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) EDITORIAL

This magazine was created using :

WELCOME TO THE LATEST ISSUE OF FULL CIRCLE. g /

s per usual we have some Python, FreeCAD, Inkscape, and Kdenlive. To round things off I've /

written up a quick HowTo on installing UBports (Formerly known as Ubuntu Touch) on your
devices. | have a Meizu MX4 phone and a BQ M10 tablet which both had Ubuntu Touch OTA-15 on
them. UBports have now released the First version of non-Canonical Touch: UBports r1. Previously
it would have meant installing this to your device via the command line, but the UBports team
have now released a nice GUI that will do all the hard work for you. So, get your devices charged
up and ready to go. There are some changes though: the Today scope isn't part of the default
UBports, neither is Here maps (UBports don't have the license for that), but most of the familiar
stuff is there, or can be installed from either the (soon to close) Ubuntu Store, or via the installed
Open Store. Just remember that UBports is still very young and very much under construction. Find Full Circle on:

w goo.gl/FRTML
-

LibreOffice

The Document Foundation

A new series begins this month from SJ Webb (formerly of Chrome Cult) who is going to use

this new column (well, replacing his previous one) to discuss the medical research that he does Facebo'ok.com/Fullcircle

using Linux. Now, brace yourselves, it's not Ubuntu. It's Fedora! So this is probably the first non- mdgazine

Ubuntu series in the history of FCM. No pressure SJ. No pressure. =4 twitter.com/#!/fullcirclemag

— http://issuu.com/fullcircle

Don't forget to keep in touch. Send in your comments to fill the Letters page, and your © magazine

desktop screenshots for the My Desktop section. Send it all to me, Ronnie, at:

ronnie@fullcirclemagazine.org “ htp://www.magzter.com/

— publishers/Full-Circle

The Full Circle Weekly News is still going, allbeit that I've missed a couple of Weekly News:

weeks due to work, but thank you to all those who download and listen. E E

http://fullcirclemagazine.org/f
:m eed/podcast

http://www.stitcher.com/s?fi
d=85347&refid=stpr

E E = http://tunein.com/radio/Full-
®  Circle-Weekly-News-p855064/

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org
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NEWS

WPS OFFICE's LINUX
DEVELOPMENT HAS BEEN
HALTED

sers looking for a Microsoft

Office clone on Linux will be
disappointed to hear that WPS
Office’s development on Linux has

for Linux was released almost one
year ago, with the most recent
version being v10.1.0.5672 Alpha.

The fact that development had
stalled was raised after one
Twitter user reached out to WPS
Office to ask why there hadn’t

response came back saying that it
was "on a halt" and that it needs
“community builds”; there's little
chance that community builds will
become a thing within the next

is not even open source, making
community maintenance
somewhat of a challenge.

In a follow-up tweet, WPS
Office did confirm that while the
focus right now is on mobile, they
will Focus more on Linux towards

Submitted by Arnfried Walbrecht

the end of the year. The response
. came when a user asked if the

. office suite will be made open

: source.

Source:

. DEBIAN GNU/LINUX 9 :
. “STRETCH"” WILL SHIP WITH
. NEw DiGITAL FORENSICS
: TooLs

. K,
been a new release for a while. The ' Last week, we told you about

the announcement of the

. release date of Debian 9.0 Stretch
. GNU/Linux distro. According to the :
: announcement, Debian 9.0 is

. slated to arrive on June 17, 2017.
few months given that WPS Office : (Fj’I'IOI' fo that, another exqtmg

: development was made in the

: Debian world in the form of

. release of systemd-free Devuan

: 1.0.0 distro.

Debian 9 GNU/Linux release is

: supposed to ship with many digital :

. forensics tools and their

. dependencies. Spotted by

. Softpedia’s Marius Nestor, the

: announcement was made by

. Debian developer Michael ‘mika’
: . Prokop.

: https://www.neowin.net/news/wp :
. s-offices-linux-development-has-
: been-halted

been halted. The most recent build :

Prokop wrote: “Debian/stretch

AKA Debian 9.0 will include a
. bunch of packages for people
. interested in digital forensics.”

. be maintained by the Debian
. Forensics team. They'll also be
: accompanied by their libraries.

Some of the digital forensics

© tools shipping with Debian 9 are as
. follows: :
.« bruteforce-salted-openssl
. e cewl

.« dislocker

. *pompem

. »unhide.rb

Source:

https://fossbytes.com/debian-
. gnulinux-9-stretch-digital-
: forensics-tools/
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. OWNCLOUD CONFERENCE
: 2017 ANNOUNCED FOR

. SEPTEMBER 20-23 IN

. NURNBERG, GERMANY

wnCloud Conference 2017 is
an event targeted at

. ownCloud developers and users

. alike, and it looks like the

: upcoming one is the fourth ever,
. : opening its gates on Wednesday,
He added that the packages will September 20, until Saturday,
. September 23. Over 200 people

. from all the corners of the world
. are expected to attend the

. conference.

There, you will attend two days

. of conference and three days of

. hacking and hands-on, so no

. matter if you are an ownCloud

. developer, contributor, reseller,

. hoster, admin, user, translator, or
. even value-adder, you are

. encouraged to attend oCCon17

. this September for another round
. of ownCloud hacking.

Take a look at the official

© website of the conference if you

want to learn more about how to
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get there, where to stay, etc., and
please try to keep in mind that the
call For sessions and sponsors is
now officially open. Registration
will also open in the coming days
for attendees, so bookmark the
event's page for upcoming details.

Source:
http://linux.softpedia.com/blog/o

instead of the Folder Widget that
was used until now. Folder View

. features spring loading

- functionality which you can see in
- action in the gallery below, space-
: saving icon grid, unified drop

: menu, and better mouse behavior.

Source:

http://news.softpedia.com/news/k

wncloud-conference-2017-
announced-for-september-20-23-

. de-plasma-5-10-officially-released- :
: folder-view-is-now-the-new-

default-desktop-516127.shtml

in-n-rnberg-germany-516146.shtml :

KDE PLAsmA 5.10
OFFICIALLY RELEASED,
FoLDER VIEW Is Now THE
NeEw DerauLT DESKTOP
hen the Beta milestone
launched two weeks ago,

KDE also unveiled all the features

major release, which will make its

way into the software repositories : Nx systems that allows standard

. . . users to run specific commands as
in the coming weeks, so you should : 5 gyperuser, such as adding users

or performing system updates.

of your favorite operating system

already have an idea about what's
new.

If not, let us tell you that KDE
Plasma 5.10 packs Folder View as
the default desktop interface

PATCHES AVAILABLE FOR
. LINUX SUDO VULNERABILITY :

Red Hat, Debian and other

Linux distributions yesterday

. pushed out patches for a high-

. severity vulnerability in sudo that
. could be abused by a local attacker :
. to gain root privileges. '
they managed to implement in this :

Sudo is a program for Linux and : lightweight nature. If you have an

In this case, researchers at

. Qualys found a vulnerability in
: sudo's get_process_ttyname

function that allows a local

attacker with sudo privileges to
run commands as root or elevate

privileges to root.

An alert on the sudo project

. website says SELinux must be
: enabled and sudo built with

: SELinux support for the

- vulnerability to be triggered. Sudo :
: 1.8.6p7 through 1.8.20 are

affected. Users should update

. sudo to 1.8.20p1.

Source:

https://threatpost.com/patches-
. available-for-linux-sudo-
. vulnerability/125985/

. BopHI LiNux 4.2.0
. UBUNTU-BASED OPERATING
' SYSTEM NOW AVAILABLE

odhi is an interesting Linux
distribution thanks to its

. older PCthat isn't particularly

: powerful, the operating system :
. could breath new life into it. Unlike :
: some other distributions that are
light on resources, Bodhi is not

. ugly - its Moksha desktop

. environment looks rather modern.

- : a major cyber attack. That is,
* 1 highly recommend giving the OS a : o Y

try.
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Today Bodhi reaches version

. 4.2.0. It is quite the boring release,
: as there isn't much to it. It is

. merely a rollup, incorporating

. many of the updates that were

. released since the previous stable

. version, 4.1.0. If you are already

© running Bodhi and have been

- installing updates, there is no

© reason to bother -- this is more for
. those that aren't already running

. the OS.

Source:

https://betanews.com/2017/05/31
. [bodhi-linux-420-ubuntu/

LiNux BiTcoIiN USerS NEED
. TO BE AWARE OF THE NEW
. SAMBA VULNERABILITY

As is the case with any potential

cyber threat these days, it is

- unclear what the impact will be

. exactly. A new Samba vulnerability
. has been discovered, which can

- affect Linux distributions as well.

. This means anyone who runs a

. version of the Linux operating

. system on their computer may find
. themselves on the receiving end of

unless they take notice of

h contents
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mitigation options available to
them.

More specifically, Linux and
Unix system are susceptible to a
Samba vulnerability, which could
result in attacks similar to the
global WannaCry ransomware
outbreak a few weeks ago. All

versions of Linux and Unix released :

on March 1, 2010, and later are
vulnerable to this attack vector as
of right now. It is possible for
criminals to remotely exploit the
Samba vulnerability. Moreover,
hackers could upload and execute
payloads on the infected systems.

For the time being, it does not
appear there are any active
exploits available right now.

Source:
https://themerkle.com/linux-

the-new-samba-vulnerability/

IDEA OF LINUX IN CARS

he Linux Foundation's

Automotive Grade Linux
project is celebrating its First big-
name user, after Toyota said it will

employ the OS in the 2018 Camry
model it will sell in the United

: States.

Automotive Grade Linux (AGL)

. is an effort to create a cut of Linux :
. capable of being dropped into cars :
: with minimal integration hassles,
: so that auto-makers and

manufacturers of in-car electronics :
- can all build to a common standard. :

. LINUX MINT 18.2 'SONYA'
. BETA UBUNTU-BASED

. OPERATING SYSTEM NOW

. AVAILABLE FOR DOWNLOAD

The Camry will use AGL in its

infotainment system, which is
. where the project currently
. focuses its efforts.

In future the project's

autonomous driving.

Car-makers should, in theory,

more sensible, especially if efforts

like Xen Embedded and
Automotive can let different

© services run in nicely-isolated-and-
. secure virtual machines.

Source:

Linux Mint, 18.2 "Sonya,"

. achieves BETA release. It is based
: on Ubuntu 16.04 and uses Linux

. kernel 4.8. You can download

. either the Mate or Cinnamon ISOs
. now. Yeah, it's a pre-release

. operating system so you should

. proceed with caution, but

5 - historically, these BETA rel
. like that plan because it's clear that | | = o oo Yr TNES€ releases

TOYOTA'S ENTERTAINING THE driver; increa;ingly exp.ect all §orts
- of assistance in the cabin, but if :
. those services come from multiple :
- devices it will increase cars' bill of
. materials and therefore increase

. complexity. A single unit to handle :
~ all tasks is therefore advanced as

. probably be fine.

. Sonya, but | haven't experienced
issues in that regard in the past.
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More important to users will be
the improved Update Manager,

. which now includes a new slick

. help section. Also user-facing is the
. LightDM display manager, which

. offers a prettier login screen with
https://www.theregister.co.uk/201
: 7/06/02/toyota_camry to run aut :
: omotive linux/ :

HiDPI support.

Source:

https://betanews.com/2017/06/06
i [linux-mint-182-sonya-beta/

. CANONICAL OuTs MAJOR
LiINUX KERNEL SECURITY
. UPDATE FOR UBUNTU 17.04

Today, the upcoming version of AND 16.04 LTS

. participants want the OS to handle :
. just about everything inside a car, :
. including the instrument cluster, a
. heads-up-display, telematics

. services, advanced driver

. assistance systems and even
bitcoin-users-need-to-be-aware-of-

hile the kernel update for
Ubuntu 16.10 systems

. patches buffer overflow

. discovered in Linux kernel's trace

. subsystem, which could have

. allowed a local privileged attacker
. to execute arbitrary code, it looks
. like a total of 15 and 13 kernel
have proven quite stable -- you will :
. Ubuntu 17.04 and Ubuntu 16.04
. LTS machines, respectively. For
: The Linux Mint team is making a :
. big deal of improved Bluetooth :
. support and settings (Blueberry) in :

vulnerabilities were patched for

Ubuntu 16.04 LTS (Xenial Xerus),

. users will have to install the linux-

image-4.4.0-79 (4.4.0-79.100)

. kernel package on 64-bit and 32-bit
" PCs, linux-image-4.4.0-1018-aws

h contents


https://themerkle.com/linux-bitcoin-users-need-to-be-aware-of-the-new-samba-vulnerability/
https://www.theregister.co.uk/2017/06/02/toyota_camry_to_run_automotive_linux/
https://betanews.com/2017/06/06/linux-mint-182-sonya-beta/


NEWS

(4.4.0-1018.27) on Amazon Web
Services (AWS) systems, and linux-
image-4.4.0-1014-gke (4.4.0-
1014.14) on Google Container
Engine (GKE) systems.

Additionally, you need to install A

the linux-image-4.4.0-1057-raspi2
4.4.0-1057.64 kernel on Ubuntu
16.04 LTS for Raspberry Pi 2
systems and linux-image-4.4.0-
1059-snapdragon (4.4.0-1059.63)
on Snapdragon processors. An
HWE kernel is also available for
Ubuntu 16.04.2 LTS users, namely
linux-image-4.8.0-54 (4.8.0-
54.57~16.04.1).

On the other hand, if you're
running the Ubuntu 17.04 (Zesty
Zapus) operating system, you'll
need to install the linux-image
4.10.0.22.24 kernel packages on

as the linux-image-raspi2
4.10.0.1006.8 kernel on Ubuntu
17.04 fFor Raspberry Pi 2
computers.

Source:

anonical-outs-major-linux-kernel-
security-update-for-ubuntu-17-04-
and-16-04-lts-516294.shtml

LiNux MALWARE MINES FOR

. CRYPTOCURRENCY USING
. RASPBERRY P1 DEVICES

Linux trojan detected under
the generic name of

. Linux.MulDrop.14 is infecting
: Raspberry Pi devices with the

. purpose of mining cryptocurrency. : :
. purp g cryp y : meaning the malware only targets

. Raspberry Pi single-board
computers.

According to Russian antivirus

. maker Dr.Web, the malware was

. first spotted online in the second
. half of May in the form of a script
: that contains a compressed and

. encrypted application.

Experts say the initial infection

takes place when Raspberry Pi
. operators leave their devices' SSH
. ports open to external

64-bit and 32-bit machines, as well connections.

Once a Raspberry Pi device is

After this, Linux.MulDrop.14

. shuts down several processes and
http://news.softpedia.com/news/c installs libraries required for its
. operation, including ZMap and

. sshpass.

The malware then launches its

cryptocurrency mining process and
uses ZMap to continuously scan

: the Internet for other devices with :
. an open SSH port.

Once it finds one, the malware

: uses sshpass to attempt to log in
: using the username "pi" and the
: password "raspberry." Only this

. user/password combo is used,

This is somewhat out of the

. ordinary since most malware tries
© to target as many platforms as it

. can. Nonetheless, this version of

: the malware may be still under

. development, and other username :
. & password combos may be added : announcement and said the

. at a later date.

Last but not least, Dr.Web

researchers also said they

- strain, which they named
Linux.ProxyM.

location.
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Source:

. https://www.bleepingcomputer.co

: m/news/security/linux-malware-

. mines-For-cryptocurrency-using-

raspberry-pi-devices/

. FINALLY! UBUNTU 17.10
. DAILY BUILDS USING

. GNOME DEeskTop By

. DEFAULT

n the past couple of months, the
world of open source was

. dominated by Ubuntu’s upcoming
. switch from Unity desktop to

. GNOME. Ubuntu boss Mark

. Shuttleworth made this

. Ubuntu GNOME development

. team will be merging with

- Canonical's Ubuntu Desktop team.
. Since then, people had been

. discovered a second Linux malware ;| wondering about the future of

infected, the malware changes the :

: k : Ubuntu Desktop.
. password for the "pi" account. :

Well, after some wait and

As this malware's name implies, . development work, the Ubuntu

© this Linux trojan is used to start a
. SOCKS proxy server on infected

. devices, which the trojan's author
: then uses to relay malicious traffic, :
- disquising his real identity and

: 17.10 daily builds are shipping with
. default GNOME desktop

. environment. This way, Ubuntu has
. finally ditched the Unity desktop in
: the true sense, which had been the

default choice since 2011.
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At the moment, LightDM is the
Ubuntu display manager, but the
final version will ship with GDM.

are early releases, so expect a few
bugs while trying them.

Source:
https://Fossbytes.com/ubuntu-17-
10-daily-build-gnome-default/

How 10 USE LINUX'S BUILT-

here are USB sticks that will

destroy your computer, USB
sticks loaded with spyware, and
even official enterprise USB sticks
infected with malware. Last, but
never least, when it comes to

stealing data from a computer, you
. attributes. It enables you to lock-

- down all USB devices from user
. space.

can't beat a USB stick. There are
devices like the USG USB stick
firewall, which can protect you, or
if you're a Linux user, you can
always stop attackers armed with
USB sticks with USBGuard.

As anyone who's ever watched
a TV show with our heroes
sneaking out sensitive data from a
computer with a USB stick knows,

Windows and Macs are easy to
crack with USB-borne tools. In the

- real world, Linux-based USB
. distributions such live-boot Tails

LightDM has two sessions: GNOME :

and GNOME Wayland. These builds : makes this easy. USBGuard can

- stop any such attack.

USBGuard, as current stable

. Linux kernel maintainer Greg

- Kroah-Hartman recently pointed

. out, has been around for over a

. decade. For some reason, this user-
. space tool, which provides access

- control to USB devices, is not well

- known. It should be. It's a great

IN USB ATTACK PROTECTION
. protect a Linux desktop or server.

addition to anyone needing to

This software framework is

. designed expressly to protect your
. computer against rogue USB

- devices by implementing basic

- whitelisting and blacklisting

capabilities based on device

Source:

http://www.zdnet.com/article/how
: -to-use-linuxs-built-in-usb-attack-

LiNnux 4.14 WiLL BE THE

. NEXT LTS KERNEL BRANCH

n a Google+ post, Linux kernel
developer and maintainer Greg

. Kroah-Hartman said that Linux

. kernel 4.14 will be the next LTS

. kernel series. He asked for

. suggestions from the community
© and told that 4.14 will remain

. supported for at least two years. If :
. the development process gets

. completed at the regular pace, we
© can expect to witness the final

. release in November. Last year in

. August, we told you that Linux 4.9 :
. was going to be the next LTS kernel :
: release. It arrived towards the
. November end and brought tons of :
. new features and hardware

. support. That official

© announcement was first made by
. renowned Linux kernel developer
. Greg Kroah-Hartman.

In his post, Greg wrote: “As no

one seemed to make 4.9 blow up
* too badly, let's try this again! 4.14
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== next LTS kernel.” He further
wrote that Linux kernel 4.14 will be

supported for at least 2 years.

Source:

. https://fossbytes.com/linux-4-14-
. next-lts-kernel/

UsBunTU 17.10 TO IMPROVE
. SECURE BOOT FOR BOOTING
. WINDOws FROM GRUB,

- AND ENABLE PIE

he first Alpha builds of Ubuntu
17.10 are almost here, due for

. release next week on June 29,

: 2017, for opt-in flavors, so the

. Ubuntu developers are working

. around the clock to add various

. new features, such as PIE (Position
. Independent Executables) support
. enabled by default for better

. security, as well as some other

, _ improvements in many areas of

- Now, first spotted by Softpedia, | tarest like Secure Boot.
- Greg has once again announced on
. his Google+ page that the next LTS :
. kernel branch will be Linux kernel
: 4.14.

PIE support is good news for

© Ubuntu Linux users as all PIE-

. enabled binaries will now be

. automatically loaded into random
: locations within the virtual

. memory, along with all of their

" dependencies, each time the

h contents
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respective applications are being
executed. This makes Return
Oriented Programming (ROP)

attacks harder to execute properly.

Among other noteworthy
enhancements that are coming to
the Ubuntu 17.10 operating
system later this year, we can
mention the implementation of
Netplan, Canonical's consolidated
YAML network configuration
across Ubuntu, in the Ubuntu
Cloud images. Netplan is also

being used by default to configure :
. either update your exisiting

. installation or download the new
- installation media from the

. project’s website. Last month, we :
. reported about the Debian Release :
. Team's plans to ship the final

networks when installing an
Ubuntu Server via the Debian
Installer.

Other than that, there's good
news for those who want to boot

Ubuntu Linux alongside a Windows
: GNU/Linux distribution on June 17.
. Well, acting well on their promise,

. they have shipped the new stable
. version, i.e., Debian 9, code named :
. Stretch. For those who don’t know, :
. Debian codenames are basedon
. the characters in the famous

- animated movie Toy Story. This

0S, as the Ubuntu developers are
working on improving Secure Boot
chainloading so you'll be able to
properly boot Windows from the
GRUB bootloader. Some patches
were also added so that u

Source:

http://news.softpedia.com/news/u :

purple rubber toy octopus, Stretch. Aardvark) by default.

buntu-17-10-to-improve-secure-
boot-for-booting-windows-from-
grub-enable-pie-516534.shtml

DEBIAN 9 ‘STRETCH'

. GNU/LINuX DisTRO

RELEASED

he Debian Release team has

: finally released the Debian 9.0 :
. “Stretch” stable GNU/Linux

. distribution. Named after Toy
. Story’s rubber toy octopus, Stretch, :
. this release will remain supported
- for 5 years. Debian 9 ships with

. Linux kernel 4.9, new digital

. forensics tools, GNOME 3.22,

default MariaDB, etc. You can

release of Debian 9.0 “Stretch”

release is named after the glittery

After a combined effort of

" Debian Security team and Debian

LTS team, this release will be

supported for the next 5 years. The
Release Team has also dedicated

. this release to Debian founder lan
: Murdock, who passed away in
December 2015.

Debian 9 could be easily called

. one of the most important Linux
. distro releases of 2017 because in

the upcoming months, tons of

other distros will be based on it.

Source:

https://fossbytes.com/debian-9-
stretch-features-download-

. CANONICAL WANTS TO ADD !
: . perform for continued feedback on

. the work done so far by the

. Ubuntu Desktop team for the

: upcoming release of the operating
. system, Ubuntu 17.10.

. HARDWARE ACCELERATED
. VIDEO PLAYBACK BY
. DEFAULT TO UBUNTU

n his latest report, Canonical's

. B Will Cooke reports on the efforts
. the Ubuntu Desktop team is
. making to enable hardware-
. accelerated video playback for the :
: upcoming Ubuntu 17.10 (Artful

According to Will Cooke, the

" team's goal right now is to lay the
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groundwork for a solution that
would enable hardware-

. accelerated playback of video files
. by default, with a focus on making
. it work on Intel graphics cards.

. Suppor for Nvidia and AMD

: Radeon GPUs should come at a

. later time thanks to Canonical's

. new testing infrastructure.

The Intel SDK (Software

. Development Kit) issue with the

: LibVA library should soon be

. resolved as Intel is currently

. working on a fix. In related news,
© Canonical announced that it will

. soon unveil a call-for-testing

. programme for Ubuntu, inviting

users to take part of small and

quick tests that they can regularly

This will help the Ubuntu

. Desktop team and Canonical

. ensure the overall quality of the

© Ubuntu Desktop Live images is

. kept high throughout the entire

. development cycle, which will end
: on October 19, 2017, when the

. final release of the Ubuntu 17.10

© (Artful Aardvark) operating system

hits the streets.
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NEWS

Source:
http://news.softpedia.com/news/c
anonical-wants-to-add-hardware-
accelerated-video-playback-by-
default-to-ubuntu-516555.shtml

CANONIcAL OuTs MAJOR

SECURITY UPDATES FOR ALL :
. kernels are linux-image-4.4.0-1059- :
: raspi2 4.4.0-1059.67 for Ubuntu
. 16.04 LTS for Raspberry Pi 2, linux- :
. image-4.8.0-1040-raspi2 4.8.0-

: 1040.44 for Ubuntu 16.10 for

. Raspberry Pi 2, and linux-image-

: 4.10.0-1008-raspi2 4.10.0-1008.11
- for Ubuntu 17.04 for Raspberry Pi
. 2. Again, please update your

. installations to the new kernel

- builds as soon as possible.

SuPPORTED UBUNTU LINUX
RELEASES

C anonical released major kernel
security updates for all
supported Ubuntu Linux operating
systems patching up to eleven
vulnerabilities across all of the
supported architectures.

Most of the patched kernel

vulnerabilities in these updates are

new, and they've been recently

Therefore, it's now time for OS
integrators to update their
repositories and keep users safe,
and Canonical is always known for
doing a great job releasing up-to-
date kernels for Ubuntu.

After the update, check if
you're running linux-image
3.13.0.121.131 on Ubuntu 14.04
LTS or linux-image-lts-xenial
4.4.0.81.66 on Ubuntu 14.04.5 LTS

with HWE kernel, linux-image
4.4.0.81.87 on Ubuntu 16.04 LTS or

. linux-image 4.8.0-56.61~16.04.1 on :
- Ubuntu 16.04.2 LTS with HWE

. kernel, linux-image 4.8.0.56.69 on
- Ubuntu 16.10, and linux-image

© 4.10.0.24.26 on Ubuntu 17.04.

The updated Raspberry Pi 2

Source:

http://news.softpedia.com/news/c :
fixed upstream in the Linux kernel. : snonical-outs-major-security-
: updates-for-all-supported-ubuntu-

. linux-releases-516567.shtml

. SYSTEM76 DEVELOPER

. Works oN GNOME

. ENcRYPTED HOME FOLDER
. SUPPORT FOR UBUNTU
17.10

S ystem76's kernel engineer
Jeremy Soller announced that

: he's been working on bringing

. encrypted Home folder support in
. the GNOME desktop environment
. for the upcoming Ubuntu 17.10

. (Artful Aardvark) operating

. system.

Last month, the Denver-based

. computer reseller specializing in

. the sale of laptops, desktops, and

. servers pre-loaded with the
- Ubuntu Linux operating system

. revealed their plans for preparing a

. consistent GNOME experience for
. their computers powered by

: Ubuntu 17.10 later this year when
. the OS launches officially.

While not many were impressed

by the new Pop theme that

. System76 wants to offer by default
. for their Ubuntu 17.10 system with :

. GNOME desktop, some were

. thrilled to learn that KDE Connect
- will become a First class citizen to
. provide users with seamless

. notifications from their Android

. devices.

. And now you'll also be surprised
: to find out that System76 planson :

. allowing the Home directory on
" new installs of Ubuntu 17.10 with
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the GNOME desktop environment
to be encrypted during the

. creation of a new user, a

. Functionality that appears to be

. implemented in the CreateUser D-
: bus call.

Source:

: http://news.softpedia.com/news/s
: ystem76-developer-works-on-

: gnome-encrypted-home-folder-

: support-for-ubuntu-17-10-

: 516602.shtml

h contents


http://news.softpedia.com/news/canonical-wants-to-add-hardware-accelerated-video-playback-by-default-to-ubuntu-516555.shtml
http://news.softpedia.com/news/canonical-outs-major-security-updates-for-all-supported-ubuntu-linux-releases-516567.shtml
http://news.softpedia.com/news/system76-developer-works-on-gnome-encrypted-home-folder-support-for-ubuntu-17-10-516602.shtml

B eing a self-taught
programmer and web
developer, | frequently hear
questions like “how did you get :
started?” or “how did you learn this :
on your own?”. This month, |
thought that dedicating an article
on how | approach learning a
programming language might be a
good way to formulate my future
answers, and to encourage anyone :
who has even a passing interest to
begin their journey. | will be
splitting this article into two
distinct sections - local (i.e.
programs to be run on your local
machine) and web (web apps,
websites, etc).

No. This article is geared

. towards my personal approach to
. learning a language. I'll refer to

. some websites and books, but the
. actual learning of the language is
. out of scope.

. A FEW GENERAL POINTERS.

The following points apply to

. Once you're comfortable writing

WHO IS THIS ARTICLE FOR?

© to enable one to save time.

This article is geared towards
anyone remotely interested in :
programming, but who is uncertain :
about where to begin, or what
approach to take. This can be
designers who feel they ought to
learn a little about HTML and CSS,
to budding computer enthusiasts
who want to learn a programming
language for future careers.

However, it is not supposed to be a

. crutch when you forget the syntax.
- few. There isn't typically a “best

. language”, although there are

. scenarios where some languages

. are better suited for a particular

. task. If you don’t know what

- language to learn, there are a few
. ways to decide. Either see what
© programmers in your local area are

* Always try something new. Do

. not stick to the same program

. format - even if you just work on

. improving the help menu in every
. program you write, or trying to

. reduce any repetitions. You may

: struggle a bit, but it will help you
" learn.

« Look at some open source
: WILL THIS ARTICLE TEACH ME :

. A LANGUAGE?

. immensely if you look at older
programs.

. . LocaL
. the code without a helper, feel free :

There are a mass of local
programming languages - Python,
C++, Perl, and Java just to name a

learning (via job postings), or see
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~‘)‘ COMMANDI& CONQUER"™ How Do)l Learn To Program?

Written by Lucas Westermann

. what languages are supported by
. projects on GitHub. You don’'t need
. to contribute, and you don't need
: to feel too comfortable with your
. skills. Even just viewing someone
. else’s source code can help you

. test your understanding (i.e. can

. you tell what the code does), as

. well as seeing examples of things
. to do (or not do) with regards to

. formatting and comments.

: « Lastly: Comment everything.
Wh.ile this is a terriﬁc habit to bl:lild - you Feel comfortable in. An IDE is
. up if you're planning to make this a :

anything you decide to learn, and is : profession, it will also help you

therefore in a separate section:
. » Do not rely on autocomplete or
: tools like Emmet too early on.

your favourite devices (computers,

. phones, RPi, etc). It can even be
. something as arbitrary as liking the
- logo.

. THE APPROACH

Learning a local language will

typically require a bit more setup
. than a web language. You'll want
. to find a good IDE or text editor

. very useful when learning

. something like C++ or Java, as the

. tools included can help you debug

. issues early on. Personally, | prefer
. atext editor, as it's something I'll

. always have access to, instead of

. relying on tools included in an IDE.
: You'll also want to set up a good

. Folder structure to keep your

. source code, and possibly even

. store it in a Git repository (or

. something like Dropbox). That way,
. you can recover previous iterations
. of code, if necessary, or easily

. carry it between devices.

Lastly, ensure you've installed a
compiler orinterpreter for your
chosen language. Once you can run

h contents
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it in a terminal or within your IDE,
you're all set.

* After you have your environment
set up, look for any official
tutorials/tours. These typically
cover some basic ‘hello world’
programs. While the programs
themselves aren’t very creative,
they help you learn the syntax and
the way a language functions.

World program, try to branch out
into user input and/or command-
line arguments (depending on the
language). As the most useful
applications require some form of
input, it's useful to learn this early
on. | typically do this using the

official documentation of features, :
as opposed to a full-fledged guide. :
© orjust normal text files.
.+« Reading information.
.« « Executing commands from your
. desktop or their
: equivalents

a comparison of various languages. :

* The next step should be to
branch out and learn some of the
oddities or strengths of your
language. You can typically find a
listing of these features by finding

* At this point, | always evaluate
the utility of the language. To do
so | ask the following questions:

* » Does this language suit the way

| think/work?

e+ |sitin demand (i.e.in the
workplace)?

*+ Can | live with any
drawbacks/oddities?

+ Canit do everything I plan to
achieve?

. «If you answered yes (or even

: 'maybe’) to these questions, you'll
. probably want to continue learning :
. the language. To do so, I'd

. recommend either finding some
. need that you want to fill, or

- finding a good website with

- challenges, which you can

- implement in your chosen

* Once you've completed the Hello :
.« Here are a few things you may
. also want to focus on:

.« e+ Testing (writing tests, as well as :
. simply debugging issues). :
: «+ Sharing/Compiling (i.e. how can
: you package this program up to

. putting it on a new computer).

language.

« « Storing information/data. This

(such as using s to list files).
* « Regular expressions. Even just

learning a few standard regex for
. searching strings or filenames will

be useful.

.« Lastly: learn a new language! Or,
© at least, stay up-to-date on the

. new versions of your chosen

- language. To keep your skills sharp © o5t “3ngular, etc) that offer more
- and your habits ingrained, you will : . '
: want to regularly try to learn
. something new.

WEB

Web languages can be a bit

. quicker to the starting line than
. local languages. Using something
. like CodePen or a JS Fiddle, you
. : can easily write some HTML, CSS
can be done with databases, JSON, -~ and JavaScript without having to
. worry about an IDE or a hosting

- solution. You should definitely not

work solely with this
approach, but if
. you're not

W, sure
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whether or not to devote time

. here, it's an easy way to try it out.

It may be confusing to see

. HTML, CSS and JS in the first step
. of my approach. You may be

. wondering what's left. There are a
. variety of frameworks (bootstrap,

. functionality to the standard

: HTML. There are also other

. languages (such as Go, Python),

. and expansions on JavaScript (such
. as ECMAScript).

To set up your development

. area locally, you'll need a text

. editor (you can also go for a

. WYSIWYG (what you see is what

© you get) program, but | would

- really not recommend it).

. Personally, | use the Atom text

. editor. Beyond the text editor,

- you'll also want some sort of LAMP
. stack (Linux Apache, MySQL, and

© PHP). My recommendation is not

. toinstall it on your main system -
. instead, you can set up something
. like Vagrant (a VM) or Docker (a

. containerization tool). This is for

© two main reasons - if you use

© frameworks or tools like Node or

. NPM, you can more easily control
. the installed versions for optimal
" support, and because Docker is
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gaining massive popularity in the
workplace. Docker is also portable,
making it easier to carry your
projects over to a new computer.
I've previously written about
Docker in FCM#107. If you're

a local development server built

(covered in C&C in FCM#120) also

offers a local development site for :

working on HTML, JS and CSS.

THE APPROACH

e Learn HTMLS5, CSS and JS. You
don’t need to master JavaScript,
but you do need a basic

understanding of it. Neither HTML : ) o :
. properties, as opposed to finding a :
. preprocessor. You'll also want to
creating a basic 'hello world' HTML look into something like Grunt or
. Webpack to use autoprefixer,
ready to carry on. This can easily be : which will help redgce how much
. CSS you have to write (see FCM

* The first step | would recommend #120 Fo.r my WebPack article). If

- you decide to focus on a language
. like Python or Go, you'll want to

. make sure you install it correctly

- and can run the commands from a
. terminal. If you choose to learn

- PHP, make sure support is

. enabled/installed on your system
. or Docker (using Apache or Nginx). :
- Or perhaps you're just interested

nor CSS are terribly complex - the
moment you feel comfortable

page with a bit of styling, you're
done in CodePen.

is learning the “modern web” -
HTML5 (which should have been
done in #1), @supports, Flexbox,
and CSS Grids in CSS 3. The three
elements of CSS | listed are
currently supported in the most
recent versions of every popular
browser, and mitigate a lot of
headaches that developers

previously had. If you begin a
project with the goal of supporting

. older browsers, | would still

- recommend beginning with the
. modern tools, and then creating
. either a fallback stylesheet, or
looking at Python or Go, both offer :
. @supports. If you're unsure what
into the compilation tool. WebPack :
. versions of HTML and HTMLS5, you
should look into the new elements :
- introduced in HTMLS5 (such as

. <main>, <aside>, <footer>,

. <header>).

.+ At this point, you should decide
- on what language you're focusing
- on. If you just want to continue

- learning HTML and CSS, you may

wrapping the modern code in

the difference is between old

want to look into CSS custom

in learning about AMP

(Accelerated Mobile Pages) by
Google.

: «You should begin with a tour or

: tutorial on the language you've

. decided upon. Depending on what
. language you're looking at, the

© steps may vary.

.« After the tour or tutorial, you'll

: want to see about integrating

. what you learned about HTML and

CSSinto the new language. In Go

- and Python, this means
. templating, and, in JS frameworks, :
. you'll probably already be :
© integrating some of this.

.« Content. Here you should focus
: on how to get content into your

. website or web app. This can be

. databases, a content management

DESIGN

system, a static site generator

: (such as grow or jekyll) or pulling

. information from a feed (RSS or

- JSON). If you use a content

: management system, | would

: recommend starting with an API

. Content Management System

: (such as Cockpit) first, as it can

. help you understand how all CMS
. systems work, as opposed to

: jumping right into something like
: WordPress.

.« Testing. You should look at your
: resulting website or web app on a

few different devices - phones,

© tablets, computers, and varying

browsers. You'll quickly
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understand how wide-ranging the
support is, and how many issues

: can crop up. Don’t be disheartened
: -you don't typically need to

. support every possible device, and
: there are a variety of tools to help

. you improve support.

: o Lastly, deployment. You should

. look into how you would go about

. hosting your application, and also

. how you would “go live”. This can

. be FTP + Docker + DigitalOcean, or

Git + Heroku, or GitHub Pages +

. Git. Every combination has its

. strengths and weaknesses, which
: is why you should do some

: research to see what works for

: your language choice.

While the approach above

. focuses on the programming

: aspect, creating a visually

. appealing site is largely dependent
: on your design. At any time after

. Step 2 in the approach above

. would be an acceptable time to

. start reading on design

. approaches. Covering things such

. as Material Design, or reading

- articles from Smashing Magazine

. or CSS-Tricks are a good place to

. start. There are also a few books

" that I highly recommend: Smashing
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Book 5 (From Smashing Magazine)
is written by a variety of authors,
and is a terrific insight into
common design approaches. Also,
Hardboiled Web Design by Andy
Clarke (Fifth Edition) is an
excellent read on new

for creating modern websites.
Both are available in physical

copies, or digitally. Even just taking : Project Euler (largely mathematical :

the time to analyse source code on programming challenges) -

. https://projecteuler.net/

websites you like is a terrific way
to learn - | would recommend

keeping either a local wiki or some 2016/2017 MUST-KNOW Web

. Development Tech Video
. (YouTube) - :
) ) ) . https://www.youtube.com/watch?v :
Naturally, if you're not planning to . —sBzRwzY7G- :
. k&index=7&list=PLQjv2GANsZ1JA
: Kzoz631tlylOZiJ3T2R6

form of journal outlining things
you've seen that you would at
some point want to implement.

turn this into a job (or even put it
on your CV), you can choose to
ignore anything outlined here.

to anyone who was feeling
overwhelmed by the mass of
options and instructions to be

tips you'd like to share, send them
to me at
swest34+Fcm@gmail.com. | will
collect any responses together
into an article at a later date. Feel
free to also email me with any

questions, suggestions, or ideas

. for articles.

FURTHER READING

_ ) CodeFights (programming
technologies, approaches, and tips - challenges) -

https://codefights.com/home

CodeAcademy (website to learn

| hope this article proves useful coding with Free courses) -

. https://www.codecademy.com/

. Code School (website to learn

found on the web. When in doubt - . 4ing with some free courses) -

start with a basic ‘hello world’, and https://www.codeschool.com/

then go from there! If you have any

: Videos/Workshops from Google
: 10, the AMP Conference, or

. Beyond Tellerrand (all Found on
: YouTube).

C&Cin FCM #121 - All about Go

. C&Cin FCM #73 - A basic
introduction to some websites for
- learning to code.

Udemy (online library of paid
. courses, frequently on sale) -
https://www.udemy.com

. Udacity (online university that

. offers micro degrees and some

. free courses, in partnership with
. Google/Facebook/etc.) -

https://www.udacity.com/courses/

- all

i
=
Lucas has learned all he knows from
repeatedly breaking his system, then

having no other option but to
discover how to fix it. You can email
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THE FuLL CIRCLE
WEEKLY NEwS

Full Circle
Weekly News

A short podcast (<10min)
with just the news. No chit-
chat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:
http://fullcirclemagazine.
org/feed/podcast

+; CECICICCEN
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HOW-T0

Written by Greg D. Walters

Python In The Real World - Pt 79

GiS

elcome back to our

Temp/Humldlty via
Bluetooth’ project. As you will
remember, last month we got
everything working to a
smartphone. This month, we will
be working on getting things up
and running on the Raspberry Pi.

The first thing we have to do is
get the RPi Bluetooth connected
to the Arduino. I'm going to
assume that you already have the
proper bluetooth software
installed on your RPi. I've installed
bluetooth-5.23-2+rpi2, bluez-5.23-
2+rpi2, bluez-firmware-1.2-
3+4rpi1, pi-bluetooth-0.1.3 and

13 on my RPi3. I'm sure that some
of those are not needed for basic
bluetooth communications. There
are many places on the web that
can explain the process. Once you
get everything installed, connect
to your Arduino bluetooth device. I
had to use “1234" during the
pairing process. | also marked it as
a trusted device.

Once we have it paired and
trusted, we need to do some

! HC-06
: pi@raspberrypi:~ $

: command-line magic to create a
. virtual serial port named

‘rfcomm1’.

In a terminal type:

: hcitool scan

You should see something like:

! pi@raspberrypi:~ $ hcitool
! scan

! Scanning ...

98:D3:31:30:49:B1

The big thing you should take

. away from this is the mac address
pulseaudio-module-bluetooth-5.0- : Of the bluetooth device (hopefully :
. the arduino) that you are :
. connected to. You will be using this :

. address in the next command.

Now, type:

command above. Yours will be

; rfcomml:
: channel 1 clean

; rfcomml :

sudo rfcomm bind /dev/rfcomm1§ channel 1 clean

: 98:D3:31:30:49:B1

different, so use it.

Now in the terminal type:

: rfcomm

Again, you should see

something like this:

; pi@raspberrypi:~ $ rfcomm

98:D3:31:30:49:B1

E pi@raspberrypi:~ $

. This tells you that you now have
© an open serial port into the
. Arduino bluetooth device.

Finally, in the terminal type:

sudo picocom -c /dev/rfcomml

In the terminal, you should see:

98:D3:31:30:49:B1

; picocom v1.7

: Where the 98:D3:31:30:49:B1 is
: the mac address of the bluetooth
: H05/06 module on the Arduino

" that was obtained from the hcitool -

! port is : /dev/rfcomml :
: flowcontrol : none :
! baudrate is : 9600
! parity is : none

databits are : 8
escape is : C-a
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! local echo is

: yes
! noinit is : no
! noreset is : no
: nolock is : no
! send_cmd is T SZ —=VV
! receive_cmd is : rz -vv
! imap is
! omap is
! emap is

! crcrlf, delbs,

; Terminal ready

This will allow you to send a “T"

for temperature, an “H"” for
humidity, or an “A” for both.

You will have to repeat most of

. this process each time you reboot

: the RPi. | made a shell script that

© contained those lines so | could run
© it as needed.

However, this series is about

using Python, so, next, we'll write a
simple program to communicate
- with our Arduino.

. A SIMPLE TERMINAL
. PROGRAM

Below is a very simple program

in Python that will allow us to
* communicate to the Arduino via

n contents



HOWTO - PYTHON

the serial port.

The first three lines import the

pyserial library and set up the port.

import serial

"/dev/rfcomml"
19200

port
baud

The next line uses only some of :

the parameters available since the
others aren’'t needed. The
important one is the timeout

parameter. If we set the timeout to :
: program properly.

“none”, the system will wait
forever (blocking) until the
specified number of characters
have been received in the .read

0, the system will return
immediately, returning 0 or more
characters from the port. We,
however will set the timeout to 1
second. You can specify the
number of seconds for the system
to wait and you can use a float
value.

ser = serial.Serial (port,
baud, timeout=1l)

In the next two lines (plus the
comment), we are simply verifying
the serial port is open and then
printing that fact.

; command or
command. If we set the timeout to :

# open the serial port

. if ser.isOpen() :

print (ser.name + ' is
open...")

Now comes the meat of the

. program. We start a “forever”

. loop, sending out a prompt to

. enter a command or to enter ‘exit’
to quit, and wait for input from the :
- user. This works perfectly for our
. purposes, since the Arduino is also :
: waiting for a command. It also

allows us to terminate the

! while True:

cmd = raw_input ("Enter
'exit':")

# for Python 2

# cmd = input ("Enter

: command or 'exit':")
# for Python 3
if emd == 'exit':
ser.close()
exit ()

Now that there is something in

the cmd variable, we encode it to
. ascii, append a CRLF toit, and then :
. write it to the serial port. We then :
. use the ser.readlines() command to :
. get the data from our Arduino. We :
. actually have several options here :
. to read from the serial port. Ifwe
. had used ser.read(), we would have :
. had to specify the number of bytes :
" to be received. Since that can '

change depending on the
command we send, that option

- isn't really a good one without a

. lot of work. We also could have

. used the ser.readline() command,
© but that only reads up to the CRLF :
. being sent in, so while good for the :
. “T" or “"H” command, the “A” :
. command which sends two lines,

would have some problems. The

. timeout value we set earlier is :
. important, since the system would :
. block until the CRLF is returned.

else:

! ser.write(cmd.encode('ascii') :

: +'\r\n")

for 1 in out:
print 1

The source (short as it is) is

available on pastebin at
. https://pastebin.com/tXWirGCX

So, that's it for this month.

We've successfully created the

Temp and Humidity sensor circuit

- and are now able to read its values

with a remote Raspberry Pi using
Python.

We'll see you next month.
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out = ser.readlines()é

=

Greg Walters is owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his fFamily.
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HOW-T0

Written by Alan Ward

Intro To FreeCAD - Pt3

In this series, we will be
examining the world of FreeCAD,
an open-source CAD modelling
application that it still in Beta, but
has been gaining acceptance in
recent years. Naturally, it is readily
available in the Ubuntu
repositories. In the second article
on using FreeCAD, we created a
simple planar object to illustrate
the use of the main workspaces

extrusion.
In this part, we will use further

object, representing a Y-junction

. between two pipes of different

: diameters. This project is actually
: quite involved from the standpoint :
: of technical drawing, since at one
: point we will be representing the
© intersection between two curved
: surfaces - which always makes for
© interesting shapes as any pipe

: welder can testify to.

C . ROLLING A PIPE
(Draft and Part), drawing tools, and :

Let us begin with the section of
: thin-walled pipe shown here. All
. dimensions are in millimeters. In

tools to create a more complex 3D this example, total length is 120

35.0000

30,0000

=

I RHNE

0aod
S0.0000
40.00440

56

| 30000

-

20,0000

-

120.0000

mm, with an initial flared section
: 30 mm long on the inside and 35

mm outside. The shellis 3 mm

: thick along most of its length, with
: aslightly thicker section where the
: flare meets the main tube body.

© This is done with a gradient of 1:2

: both inside and outside. Finally,

: the main tube body has an inner

: diameter of 40 mm, while the flare
: goes out to 50 mm internal

. diameter.

What is particularly interesting

: about this piece is the axis of

: revolution shown in dashed gray: if
: we take the outside edge of our

: object and make it revolve around

. this axis, we will be creating the

. outside shell of our solid object in
. 3D. Likewise, the inside edge of

. the wall (in dotted lines) may also
. be revolved around the same axis,

giving us the inner shell of our 3D

. object. In essence, we will be using
. a similar tool to the extrusion used
. in the last part of this series, but

: running around a circle instead of

: moving in a straight line.

To design this part, | could have

. begun within the Draft workbench
. of FreeCAD, and drawn each line

. section needed to complete a

. section of the tube wall. However, |
- actually started out with LibreCAD.
. As discussed previously, the

. LibreCAD application is best suited

Full circle magazine #122 @ 17
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to drawing objects in two
dimensions, which is why FreeCAD
had been preferred as a base tool
for this series. However, LibreCAD
does have an option to export
drawings in the widely-used DXF
(AutoCAD) file format, which can
then be imported into FreeCAD
and used as a basis to work with.
Since the lines are already
correctly positioned, it may be
advantageous to use this scheme
to set up our FreeCAD object.

In FreeCAD, begin by starting a
new project. Now choose menu
option File > Import

Now, we have several more
elements than are needed for the
tube wall. The axis needs to be

removed, as well as the (previously

dotted) lines denoting rotated
edges. The lower copy of the wall

section will also be erased, leaving

just the higher copy, ready to be

rotated. In the Draft workbench,
examine the Combo view on your

: left, and you will see each

- individual line from the DXF File,
© that can then be erased, moved, or :
. modified, as needed. :

When we are satisfied, as

. before, we will need to combine
© the collection of Lines into a single
© Wire object with the “join objects” :
: tool in the modification toolbar :
: (whose icon is the blue up arrow).
. Select all segments, eitherin the
: combo view or in the drawing itself :
. - holding down the Ctrl-key to :

:|Combo View > @

Model = Tasks

Labels & Attributes
Application
v & part3

® Wire

select multiple objects - and use

the join tool. In the combo view,

we will see the Four segments
. disappear, to be replaced by a
single Wire object.

To create the actual 3D tube,

tool from the 3D toolbar.

20N T
T

rotate
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Be sure to select the X axis to

. rotate around, since the tube

: object is symmetrical about this

: horizontal axis. Also, activate the
: “Solid object” checkbox. This will
© allow us to use this part as a

: : complete object further on, and to
. let us move to the Part workbench. : P )

: ) -, make holes in it to allow branching
: Now choose the “Rotate object :

. with the lateral piece of pipe.

. ADDING A LATERAL PIECE OF
. PIPE IN A Y-JUNCTION

: We are now going to add a

. small piece of pipe, with inner

. diameter 20 mm and outer 26 mm,
: attacking our existing tube at an

. angle of 45 degrees. The axis of

h contents
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the new pipe will intersect our
existing axis at 100 mm along its
length.

There are several ways of
could proceed as before, drawing

then rotate the piece to create a
3D revolution solid. This can be
created aligned with one of the
standard axes, for example the Y

as required. However, since the
shape of the new piece of pipe is
rather straightforward, it may be
easier to use pre-existing primitive

shapes to form it.

Let us begin by hiding the

existing tube. This is done by gomg
§ to the Combo view on the left,
creating this new piece of pipe. We :

selecting the Revolve object, and

. hitting the space key on the
the outline with Line segments and :

keyboard. It will not remove the

: tube from our project, but simply
. make itinvisible - thus making the
: construction of the smaller tube

. easier to visualize.

axis, and then moved into position :

Now, using the Primitives

toolbar visible in the Part
. workbench, let us create two

will both appearin the same
position, as “Cylinder” and

§ “Cylinder001”. Default

characteristics are a radius of 2

: mm and height of 10 mm.

3 Qb
T

cylinder primitive

. cylinders. For the time being, they

1 il
I |- ‘

[

o ' '

Full circle magazine #122 @ 19

Now, using the Combo view on

. the left, choose the First Cylinder
: and go to the bottom tab marked
: “Data". Here, change the radius to
: 13 mm and the height to 100 mm.
: This will be the solid material for

: our new tube.

Choose the second Cylinder,

. and do the same, giving it radius

: 10 mm and height 104 mm. This is
: the shape we will cut out from the
: first cylinder, making it hollow.

. However, as in the part created in

© the last article of this series, both

. cylinders end at the same Z-

: coordinate. This means FreeCAD

: can have difficulties calculating

: exactly where the cutout is to end.
: To make things more clear, let us

: move the second cylinder

. downwards by 2 mm, making it

. protrude slightly from each end of
© the Ffirst cylinder. This is done by

. editing Placement > Position > z in
: the same tab, and giving it

© negative value -2 mm.

We will now use the second

: cylinder to cut a hole in the Ffirst. In
. the Combo view, choose in

: sequence the first cylinder, then

. the second, holding down the Ctrl-
. key when choosing the second

. object. Then, choose menu option
" Part > Boolean > Cut, and the two

n contents
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cylinders should be combined into
a single hollow tube using
Constructive Solid Geometry.

vertical and needs to be tilted to
45 degrees, while the larger

: Revolution object has been placed

: at some distance from the

We are ready to assemble the
two parts of our project. Go back
to the Combo view, choose the
Revolution object - the main tube - :
and press the space key. Both
objects should become visible at
once, with a bit of zooming.

However, the new Cut object is still

coordinate system'’s origin for
. some reason, perhaps related to
: the use of a DXF file to import its

basic shape.

To tilt the Cut object, go to the

© Combo view, select this object,

Full circle magazine #122 @

. object, and modify Placement >
: Position > x value until the two
. parts are assembled in their
choose the Data tab as before, and :
: specify -200 mm for this to
. happen.

unscroll Placement. We need to
change the Axis values to [0.00,

© 1.00, 0.00] since we will be rotating :
- around the Y axis, and then change
: Angle to -45 degrees to tilt the Cut :
. object backwards to our left.

Now select the Revolution

correct position. | needed to

We still have a couple of

T | Application

Madel  Tasks

Labels & Attributes
# part3

© Revalve

B Cylinder
eylinderoty
Cylinderooz

Property  Value

» Placem... 10,00 1,00 0,000
Laksel Cylinderon?

The easiest solution for the First
bit is simply to undo our boolean
cut operation by simply clicking on
the Cut object in Combo view, and

. deleting it. We should now have

: three objects in our project: the

: Revolve object representing the

: large tube, Cylinder as the outer

: shape of the small pipe, and

: Cylinder001 the inner shape of the
© cutout. The two Cylinder objects

. will need to be rotated once more
© to-45 degrees along the Y axis,

© since the rotation we had applied
: previously concerned the

: . combined Cut object which we
: problems, however. The small pipe :

: is protruding through the wall of

. the main tube, but it is not yet

© cutting a hole in that wall. On the
. other hand, there is a piece of the
. small pipe within the large one

: that also needs to be cut off.

Combo View (-]

. have since erased.

Now, add a third Cylinder object

- labelled Cylinder002 - to
: represent the interior of the large
. tube. It should have radius 20 mm,

4

Radwes 20 mim

Heigh
Angle
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Labets B Attributes
Application
* part3
& Curt
o Fusion
O Revalve
& Cylinder
o Fusiond01
& Cylinderdd
B Cylindernd2

Property  Walue

height 124 mm, be rotated on Axis

[0.00, 1.00, 0.00] (the Y axis) by +90 :
- should end up with our final,
left by 92 mm by changing Position :

degrees, and then placed to the
> x value to-92.

Finally, we can join the two
external objects, Revolve and
Cylinder, in a single Fusion object:
the Ctrl-key pressed, and finally
menu option Part > Boolean >

Union. This should create a new

same with Cylinder001 and

Cylinder002, creating “Fusion001”. :
- which should mean making the
transition from one program to the:
. other is rather painless.

At this point, we should see only
the two Fusion objects, one
representing the material we are
adding to our project, and the

second representing the cutout or
: be cut open as needed to examine :

material we will be subtracting.
Now choose these two objects in

choose Part > Boolean > Cut. We

material into a single Fusion

before making the final Cut, can
. come in useful when designing
object called “Fusion”. Now, do the :

parts with complex CSG

is similar to that used in Sketchup,

the interior geometry and the

© instance to make
© sure thereis

: enough material
© to support any

© structural or

. pressure stresses
© that the finished
© part may

: encounter. This

© cutting open is

; _ _ : left as an

. order: Fusion, then Fusion001, and . exercise to the
: reader. Hint: try

- i © Part > Boolean >
finished tube Y-union. We can note :

the shape of the union between
: the two tubes.

- Intersection with
© another object.

section of each
piece, for

?
This technique of combining all WHAT NEXT?

the bits of our project that add
choose Revolve, then Cylinder with :

: create a complex 3D object, :
© representing a Y-junction between :
© two pipes of different diameters.
. geometries. The general workflow : The Revolution tool was used to
. create the form of a tube in 3D,
: from a plane section of the tube
. wall. The Cylinder primitive was
. used to create the form of the

. small pipe attached to the main
© tube, and then to create cutouts to

Once completed, our object can :
: empty out both forms. In the next

part of the series, we will
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© investigate the use of sketches to

: implement constraints on segment
: placing.

In this article on using FreeCAD, :

© object, and all cutouts into another : We used several techniques to

e
(3=
Alan holds a PhD in Information and
the Knowledge Society. He teaches
computer science at Escola
Andorrana de Batxillerat (high-
school). He has previously given
GNU/Linux courses at the University
of Andorra and taught GNU/Linux
systems administration at the Open
University of Catalunya (UOC).
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s many device holders will

know, Canonical has
discontinued Ubuntu Touch and
this means our devices would sit
dormant with no future updates.
Not so! UBports have come to the
rescue, and will continue to
maintain Ubuntu Touch for all
official devices which came via
Canonical, and the devices that
UBports ported Touch to. The full
list (as of writing) is:

Nexus 5

Meizu Pro 5

Meizu MX4

Fairphone 2

BQ M10 HD

BQ M10 FHD

BQ Aquaris E5

EQ Aquaris E4.5

So is there anything you need
to do? Yes. You need to flash your
device to the UBports version of
Touch. This is quite painless and
has been made moreso by the
release of the UBports Installer
software.

HOW-10

Written by Ronnie Tucker

Install UBports (Ubuntu/Touch)

1 WARNING! Flashing your device

{ will completely erase it and install [
1 a new OS. Be sure you have backed
1 up any necessary files before doing |
{ anything else.

x86_64.Applmage to your system.

Once it's finished downloading,
- you need to check that it'll

- execute. Right click on the file and
. (in the menu) go to Properties.

. DEVELOPER MODE

: Before we continue, it's usually :
: best to put your device into

. ‘Developer Mode’. You do this by
© going into System > About >

. Developer Mode. In this screen,

: yoU'll see a switch for Developer
. mode. Slide the switch to make it
- show green. A popup will appear at :
: the top of the screen asking if you
© want to allow/disallow this. You

: need to allow it.

DOWNLOAD

: The first thing you need to do is :
- download the installer. This is done :
©via:
: https://github.com/ubports/ubport :
© s-installer/releases. If you wantto
. compile source code, you can, but
: for this I'll be using the Applmage
* version. Save the file ubports-

installer-0.1.4-beta-

: There should be a tab for

: Permissions. Click that, and you
: should see something along the
- lines of ‘Allow executing file as

. program’. Check the little box

: beside that. Close that Properties
. window. Now you can double click
: on the file to run it.

On first run, you'll see the app

: window. It has a dropdown menu

. of the supported devices and is

- displaying ‘Waiting for device..." at
: the bottom.

Ubports installer

UBports Installer

Wating for device...

Please connect your device with an usb cable

Please connect your device

Flase connect your device 1o your pe
using a usb cable

Automatic detect anky warks if your
device has developer mode enabled

Please select dewvice if we can't
automatically find your device

Device

OnePlus One

OnePlus One

MNexus 5

Meizu PRO 5
Meizu MX4
Fairphone 2

BQ M10 HD

BQ M10 FHD
B Agquaris ES
BQ) Aquans E4.5
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up/down volume keys, | selected small white text at the bottom 15.04/stable. You can choose to
FAsTBOOT ~ fFastboot and pressed the power ~ saying '=> FASTBOOT mode...’ ~install the rc, or developer,
The d X 5 : button. That put the device into : : channels, but I'm sticking with
e device has to be in . fastboot mode. For the Meizu MX4 : F I . stable. Now I click install
, , i : . : LASH! AH_AAA! : stable. NOw | click InStall.
dfastboot mFodeI.DGettlngdthe . (that I'm going to use for this : :
evice into Fastboot mode is . tutorial), it was volume-down and - L .. ¢ Theinstaller will remind you
. . : ! ; With the device in fastboot, it's : y
different for each device. Formy  : hower. Again, it took a Few seconds ' . that you're about to factory-reset

: : time to plug in the USB cable. |

BQ M10 FHD, I had to turn off the - before the device reactedand it : 1 co thpe !\5le4 from the list and . @nd lose all data. Click install as
device then hold down volume-up : \yent straight to fastboot mode. clicked select. If vour device isin . long asyou don’t mind losing all
and power. This took about50r6 : No menu. : Ty - data on the device.

seconds before the device came on : developer mode, it will auto detect
: . the device for you. :

‘l’)"ith the whitejcreen. I let the . You'llknow when the device is . Now the installer asks for a
uttons go, and up cameamenu  : ; ql o : .
with sevgral optioI;s Using the in Fastblc()ot moc;le as the screen will The app agrees that it is an MX4 : password. This is your ﬂesktop -
| be blank apart from some very . and is now ready to install root password. Enter that and clic
UBports Installer UBports Installer
Ready to install! = Please reboot to bootloader

Your device: Meizu MX4 (arale) : We need to be in bootloader in order 1o
: conuune. Please hobd the power bution

T

| Read before installing: thes will lactory : :'/H A p——
reset your device and install Ubaniu : - ] K b
touch, this means it will remove all of : f/—) ﬁ | rEnOots
your data g
: Hold power button
nd

Make sure to backup all data you want :
to keep! : Vielume down buttor

Channel 15.04/s1able

Meizu MX4 Downloading Ubuntu touch..
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OK.
You're off!

After Touch had downloaded,
the flashboot text at the bottom
of my MX4 changed (I couldn’t
manage to get a photo of it) and
the phone rebooted with the
Ubuntu logo on the screen and the
installer changes to say that it's
downloading more files.

All the while, my MX4 sat there

with the purple wallpaper and

~ white Ubuntu logo.

After downloading all the Files,

the installer will begin pushing the
: files to the device.

: Now, remember how I said

: you'd lose all your data? Well, you
. probably won’t. Most times,

: flashing UBports Touch doesn'’t

: wipe the device. | threw in that

: disclaimer JUST IN CASE it does

. happen. Maybe future installers

Ubports installer

UBports Installer

Installing

Installing Wbuntu Touch on your device

and so on.
For now?
. They don't.

: device will
: reboot

: showing

. the ever

: Familiar

: Ubuntu

. loading

will wipe
the caches

The

UBports Installer

Waiting for device to enter recovery mode...

Flashing recovery and boot images

Downloading Ubuntu touch.

Downloading file 1 of 12

- while) it'll
. change to
. show the
. UBports
. loading

© screen.

. into System
: Settings >
. About it

. should say

screen, but
(after a

Going

Installing

Installing Ubuntu Touch on your device
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Ubuntu 15.04 (r1). remove all the old apps and data.|  HELp:
don’t want to end up with a device
Done! This device is now using  : that has UBports OS but with UBports Telegram Supergroup:
the UBports Touch. - Ubuntu Store apps. Remember: the : Ltips-//t me/ubports
: Ubuntu Store will close soon. :
What | did next (on my MX4) . UBports has its own OpenStore UBports forum:
was to go into System Settings > : that is installed with the OS. : https://forums.ubports.com

Reset, and do a factory reset to

. UBports bug tracking: :
: https://wiki.ubports.com/wiki/UBp :
: orts-Bug-Trackers :

Ubuntu 15.04 (r1)
: Ronnie is the founder, and editor, of

i Full Circle. His other interest is art,
:and his work can be seen at:

13}{)&,"2;11?" ronnietucker.co.uk

A
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HOW=TO Inkscape - Part 62

Written by Mark Crutch

7

ne area of functionality that The Ffirst few items all live under One important thing to note is . already the same type, it will work
has received a huge boostin : the Edit > Select Same submenu, that selecting the same “object . to select the other objects of that
0.91 and 0.92 is finding and - and offer several different ways to : type” purely refers to the type of . type; but if any one of them is of a
selecting objects. There are many : select all items which share a underlying Inkscape object - so - different type then, rather than
situations in which you may need  : particularvisualstyle. Touseany - ¢ 5rec and rectangles, or circles  © Seélecting all the objects of either
to find similar, or identical objects : of them, you must first select one 5, a(inses, are considered . type, everything is de-selected
in a busy drawing, perhaps to ; ormore object§ whose close . equivalent. ;(ou can see this effect : instead.
delete or change them all at once. : relatives you wish to also select. As : if I select the green star on the top
In previous versions, this was a - afirst example, if | select the teal line, then use Select Same > ObJect Select Same > Fill Color has no
chore, especially if you had to © square at the top left of my grid, Type. Not only are the stars . such problem: if I have both the
make the same selection multiple : then use Edit > Select Same > " selected. but so are the triangles . teal square and the green star
times. So let's look at the various i Object Type, all the other squares : they were all created using the | selected, then all the objects with
ways in which recent releases . are selected. In my image I've given : «._ o (oo § a teal or green fill will be selected
make this easier. I'm going to use | the selected items a gold colored : by the command.
this contrived grid of objectsto ~ : background to make them stand GRS ;
give you a feel for how the new out a little better, but youwon't : : . .
tools operate: © see that in normal use. * A .

__.
HxAQ I*AO A,
Hx40 BXAO **

ﬁ '”E * . *** * Frustratingly, the select by type
o o 5 Note, however, that selecting

. option doesn’t work terribly well
© with multiple items selected. If
every object in the selection is

. by color is extremely specific: it
* will only select items whose fill
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color is absolutely identical to your
starting object. There's no way to
set a threshold, in order to select
all the items with approximately
the same shade of green, for
example.

There's also a Select Same >
Stroke Color option, which does
the same thing, with the same

but based on the stroke color
rather than the fill color. For
example, selecting the teal square
once again (before executing the

on the top and bottom rows; they
all have a black stroke, even
though the stroke thickness and
dashes are different between
them. Once again, starting with a
multiple selection will result in a
cumulative set of items whose
stroke colors match any of the
objects in your initial line-up.

The counterpoint to selecting
by stroke color is to select by
Stroke Style. This matches objects
only if they have the same stroke
thickness and dashes - including

a little strict, in my opinion. Stroke
color, line caps, join type and
markers don’t seem to have an
effect, whereas the mitre limit

does. The choice of what

properties do and don't contribute

: to a “matching” line style seem :
: rather arbitrary and counter-

. intuitive, which may limit the

- usefulness of this option in many
. situations.

Even more limiting, however, is

. the Select Same > Fill and Stroke
exacting requirements for a match, :
. only with an identical stroke, but
. where both the fill and stroke

. colors also match. It's the digital

. equivalent of a club doorman not
command) will select all the shapes
. sneakers, but actually only

- allowing entry to people with

. exactly the same shoes as him,in
. the same color and style —and only :
. then if they're also the same size.

menu entry. This will match items

only refusing entry for wearing

The next tool we'll look at this

: month is the recently souped-up

: Find/Replace dialog, which can be
. opened from the Edit menu or by
. pressing Ctrl-F. The key to working :
- with this dialog effectively is to
- understand that all it's really doing :
: is a search (and possibly a replace)
. of text within the XML code that

the same dash offset, which seems
. So, first, a quick recap on XML
- using a heavily abridged snippet of :
- code representing a text object in

makes up an Inkscape document.

Inkscape:

<text id="text1178">
<tspan

id="tspanll80"

font-weight :bold;
font-family:Arial;

—inkscape—-font-

E specification: 'Arial Bold';

£i11:#000000; "

x="320.68646"

i y="86.745667">

This is some text

</tspan>

; </text>

, XML represents a tree structure :
in text. Here you can see that we
. have an opening <text ...>

. element, which gets closed by the
. </text> line at the end. Inside of
. thatis a single <tspan ...> element, :
. again being closed near the end.
. Inside that is the text itself, “This is :
. some text”. This is between the :
. opening and closing <tspan> tags,
© but is not a tag itself. This piece of
© literal text is what XML refers to as
. a‘text node’, whereas <tspan> and
. <text> are ‘element nodes’. The
. element nodes also have

" name=value pairs of extra data,
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referred to as ‘attributes’. In the
<text> node, for example, the

: id="text1178"is an ‘id’ attribute,
: with a value of “text1178". The
style="font—style:normal; . ‘style’ attribute is a little special -
. it holds CSS style data, which itself
. takes the form of a list of

‘property:value;’ pairs.

With that information in mind,

. let's take a look at the
. Find/Replace dialog, with its
. Options section expanded:

Ty Find/Replace (CErl+F) BEE]
Gy Find/Replace (Ctrl+F) @ ®
Find: ||
Replace:

search in Scope

Text w All

% Properties Current layer
Selection

= Options
General

Case sensitive Exact match

| Include hidden Include locked

Properties
< ID R Style
1 Attribute value

Fank
+ Attribute name

Object types
All types Offsets
Paths Rectangles
o & Ellipses
Groups
Clones S
Images Spirals

3 objects Found Find
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As you might expect from a
Find/Replace dialog, the first two
fields allow you to type in text to
be searched for and, optionally,
text to replace it with. The search
will match against substrings,
unless the ‘Exact Match’ checkbox
is ticked, so searching for “Fred”
will match against Fred, Freda,

Winifred and Alfred - although the :
. ‘General’ section to limit your
. search a little, if necessary.

latter two will match only if the
‘Case Sensitive' checkbox is
cleared. Interestingly, you can

search with this field left blank. As

you might guess, an empty string
matches against everything, but
the match is further restricted by
the choices in the ‘Object types’
section at the bottom. Usually you
would probably leave this set to
‘All types’, but, by setting specific

field blank, it provides a fast way
to select all the objects of specific
types — a workaround for the
Select Same > Object Type's
restriction on finding only one
type at a time.

Assuming the more common
case, where a search string is
entered, the ‘Search in’ radio
buttons determine whether the
XML text nodes will be searched,
or the attributes on the element
nodes (though the latter is labelled

as ‘Properties’ in the Inkscape Ul).
Use the former to search and

- replace text content — handy if

: you're using Inkscape as a poor-

: man’s desktop publishing program
: (though I do recommend that you

. learn how to use Scribus if you

- need to do any significant text

. layout work). Use the ‘Scope’ :
buttons, and the checkboxes in the :
. elements with a particular

. attribute name. Not as useful as
. searching for values.

Switching the ‘Search in’ control :

: to ‘Properties’ provides a great :
- deal more power, if you're

. comfortable enough with the

. insides of an SVG file to know what :
. to look For. By ‘Properties’ it means :
. attributes and attribute values,

- including CSS properties. Making a
checkboxes and leaving the search :
. might seem a little petty, but

- understanding them is key to

. making effective use of this

- section of the dialog. There you'll
. find checkboxes to tell Inkscape

- which parts of the XML it should

. search:

. «ID - Only search the value of the
- 'id’ attributes.

.« Style — Search for CSS properties
. and CSS values within the value

. part of ‘style’ attributes.

"« Font — Presumably this searches

distinction between these terms

for only CSS font names, but | was

unable to get it to work at all on
my test file. Use a ‘Style’ search

- instead.

.« Attribute Value - Search within

: the values of attributes. This

- includes searching the values of id
- and style attributes, even if the

. earlier checkboxes are blank.

» Attribute Name - Search for

Usually, searching for an

attribute value is sufficient. It will
- find matching IDs, styles and font

names, without you having to
understand how they’re stored in

: the XML. Only if it finds too much,
* is it worth switching to search only
. IDs or styles. Searching for

: attribute names is never really

. necessary for normal users, but

: might have its place if you're using
- Inkscape to work on graphics for a
. web application that carry

. additional custom metadata.

There are a couple of things to

the stroke width to zero, so it isn’t
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visible any longer. If you search for
“#fFO000" hoping to select all the

. elements with a red fill, you'll also
. select the object with no stroke.

. Although it might not be visible,

. there will still be a color stored for
. the stroke in the style attribute,

: which is enough for it to become

. part of your selection.

The second warning is with

© regard to the ‘replace’ field:

. performing a find and replace in

. text mode is generally safe; doing

© soin properties mode could have

. unforeseen results. Thankfully,

. Inkscape is sensible enough to stop
© you performing a replace

. operation if the ‘Attribute name’

. checkbox is selected, but

arbitrarily replacing strings within

. attribute values can be almost as

. destructive. It might seem safe

© enough to replace your black fills

. with white, by searching for

: “000000"” and replacing it with

. “FFFFFF”, but a series of six zeroes

© could easily appear in the

. coordinates of your objects, where
: . hexadecimal values are an error

. beware of when using this dialog in :
. 'Properties’ mode, however. Firstly, :
- it can end up selecting objects you
- didn't expect. Consider an element :
* with a red stroke; later you change

that could break your entire
drawing. If in doubt, save a backup

. of your file first.

Having used the previous tools
to make a selection, Inkscape now
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also provides a way to save that
selection for later use. The Object
> Selection Sets... menu item
opens a rather empty dialog for
managing stored collections of
selections:

|®

{iselection sets

‘Lection sets

The most important thing to
note about this dialog is that the
“+" button at the bottom does not
create a set containing your :
current selection. Instead it :
creates a new, empty selection set :
which has another “+" button next
to it. Only when you click this other :
button will your selection be ;
stored in the set. The same button
can be used later to add another
selection to any existing items in
the set.

to a set, hoping to view the
elements within it, you'll quickly

. find that there’s a rather useless
- intermediate level, labelled

. “Items”, that you also have to

. expand. If you click the triangle

. next to the “Items” entry to

. expand it, you'll finally get to a list :
. of the objects in your selection.

Selection sets L=k
Hiselection sets 4 =
g - Set1
= ltems

® text1178

® path1143

® rect1139

® rect1131

® path1135

@ path1137

+

Clicking on the cross next to an

- item in the list will remove it from

the set. Clicking on a name in the

- list will select it, whereas clicking
. on the Set itself will select all the
. items in that set. Unfortunately,

- clicking on a Set doesn’t highlight
- all the items within it, so, if you

* want to re-select all the items

If you click on the triangle next

except one, for example, you have

to highlight each entry separately
whilst holding the CTRL-key. You

: can even use the CTRL-key to
. select multiple Sets, or

. combinations of Sets and

- individual items. What you can't do, :
. however, is select something from
this dialog, then add to (or remove :
. from) the selection by CTRL- :
. clicking on objects on the canvas,

- which is a pity as it effectively

: turns Selection Sets into a separate
. selection mechanism rather than
. something which integrates

. seamlessly into your normal

. Inkscape workflow.

Selection sets are preserved

. when you save a document, :
. however they do get cleared when :
. the Edit > Clean Up Document :
. menu is used. Nevertheless, they
. have their uses - for example, as
. another means to work around the :
. restriction on Select By Type only
. working with a single type at a

. time. If you want to select, say, all
. the circles and rectangles, you

: could use the Select By Type :
. option twice, adding each resultant :
. selection to the same Set. :

The new and extended

selection tools in 0.92 are a :
- welcome addition, especially when :

working with complex documents.
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They do have their limitations and
idiosyncrasies, but hopefully they'll

© continue to mature in future
: releases to provide even more
. capabilities.

P

=

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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S 4

‘nother quick one this month,
but it's an important one:
colour correction.

Inevitably, at times, your video
will be dark (again, I'm looking at
you, mobile phone users!) and will
need some colour, and/or
brightness adjustments.

LuMA LIFT/GAIN/GAMMA

First, as ever, add a video to the

timeline.

Right click on it and go to Add
Effect >

¢/ HOW-TO

Written by Ronnie Tucker

Colour>LumalLiftGainGamma

: Audio correction |
Biur and hide ¥
: Ghroma Ho
Colour correction ] Greyscale
Crop and transfarm W Irvwert :
Fade ¥ Sepla :
Misc ¥ Technlcolor
: Mation ¥
B - LumaliftGainGamma -5 :
Lift 0084 :
Gain [0.156
Garmma 0.408) :

There's a similar, but different,

option under Colour Correction,
- but | prefer this one.

Kdenlive - Part 6

| won't go into what each slider

does, as you'll see the results when
: you move the slider (or change the
. numerical value), but the Gamma

. slider will enhance the colour of

your video. The other two will

. effectively adjust the brightness
- and contrast.

So now you know how to get

. your video files looking much

. better. The tricky bit is trying to :
get all those video files looking the

: same throughout the video :
without one being brighter/darker :
¢ than the previous one. :
Unfortunately, | don't have a fix for

: that, but my advice is to try and
keep the same lighting in your

. scenes when making the video in
: the first place. That will save time
- in the long run, effectively

. eliminating this step altogether.

iy
(=)
Ronnie is the founder, and editor, of
Full Circle. His other interest is art,

and his work can be seen at:
ronnietucker.co.uk
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RESEARCHING WITH LINUX

Written by S. J. Webb

M y occupation is a research

coordinator. | am essentially

a project manager in the clinical

research realm. My expertise

focuses on instrumentation for

osteopathic manipulative medicine

(OMM). Before | start talking about . There are a number of Linux

my career and Linux, | need to : - variants directed towards research.

describe osteopathy. N A =% “A student of life must take in each HRSVARULMESERERERIAICIRVLIT, LV
: - . Sci. | started using Scientific Linux.

_ Bl | It was originally based off Fedora

relations to other parts and systems ' or Redhat Enterprise Linux. Today,

. it is based off CentOS. CentOSis a

. great LTS distro, however the

. software packages are older and

. stable. | prefer having newer

. software in my daily distro.

. data. After collecting the data, |
. then process it and hand it off to a
. bio-statistician for statistical

- analysis. | use Linux on a daily basis
. For my various research studies.

part of the body and study its uses and

Osteopathy is the sublime art of :
treating physical somatic :
symptoms using various :
techniques of counterstrain, strain, :
and therapeutic palpatory :
treatment. This treatment is called :
OMM. Osteopathy is a fairly young :

medical science developed by AT. investigators in developing new

Instrumentation is simply the

Still in the United States. He teach{ng mthods or research i term used to describe cutting-edge : | use a Fedora Remix that is
believed the human body can heal questl.ons.u.smg OMM To quantify . technology to collect data. At my : called the Korora Project. There
itself if the musculoskeletal - the scientific capabilities of OMM, I © iversity, | use motion capture  : are a number of reasons | use
framework is balanced. In the use Instrumentation to, answer . systems and pressure pads to . Korora. It is downstream from
United States, osteopathic doctors various research questions. . objectively collect and quantify Fedora, so updates are

. implemented easily. It implements
: media codes not supported by

are considered equal to medical
doctors . Today, some osteopathic :
doctors employ OMM to treat their : . Fedora. The tools I need from
patients. However, worldwide the . z Scientific Linux are available. My
standards for osteopathic Korora 25 - . old mentor, Mike Ferarri, uses
practitioners are varied. In some Standing on Giants. : . Fedora, so | have support if | break
countries, they are family doctors . my system. Luckily the

or they are equivalent to physical : documentation for Fedora is
therapists. | work with primary thorough. The Korora Project does
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not support a forum, but there’'s an
activity thread for help via this

Engage link, or you can access their :

IRC Channel. The volunteers are
very quick in helping new users. If
you want to be involved in helping
a distro, consider contacting the
Korora Project. The Korora Project

Australia, so a time delay may
apply.

The main tools | use for my job
are varied - like my daily job
duties. As a research coordinator, |
have recruited individuals for
clinical studies, written
manuscripts, collected data sets,
processed data sets, managed

projects, trained new hires, done
basic statistical analysis, edited
videos, taken photographs,

are Fedora Spins. The Fedora Spins
would be equivalent to Kubuntu,

- Lubuntu, and Xubuntu. It is from
. encrypted files, and other duties as :
. needed. Fedora has the basic tools, :
- while Korora fills in the gaps. | use
. Kdenlive, LibreOffice, GIMP, R,

- Gnuplot, Veracrypt, Planner, and
team members are largely based in :

these Spins the Korora Project
enables XFCE, Cinnamon, MATE,

. KDE, and Gnome. | originally used
: Gnome, but my hardware barely

. supported it.

other tools. | will cover these items :

. from a rpm perspective, however | :
- will include instructions for

. Debian-based distros when

. needed.

| employ the MATE DE. This is

. the default layout as seen below
. left. They use Plank on the left side :
. of the display, which is reminiscent :
. of Gnome. It comes loaded with
; Before getting into the tutorials :
. on the various programs | employ,
. let's do a short review of the

. Korora OS. The default DE for

. Fedora is Ghnome, however there

LibreOffice, Firefox, and the

. standard fare of programs that

: appear on most Linux Distros

. today. If a person uses Ubuntu

: MATE, then using Korora MATE
a: would be an easy transition.

However, there are some key

. differences between Ubuntu and
. Korora. The installation processisa:
. bit of a bump using the Anaconda
. Installer by Fedora. You have to

- reclaim your hard drive space, and
. then approve it. Ubuntu has an

. easier installer. The command-line
. interface is very different, using

- -- sudo dnf install
. versus

" sudo apt—get

Full circle magazine #122 @ 33

commands. The software center is
in transition for the non-Gnome

. desktop environments. For a

: number of years, Yum Extender

. was the graphical software center,
. now it is being transitioned to

. DNFdragora, which will be released
© in future Korora editions. Yum

. Extender is a dead project, and

. DNFdragora is the new

. replacement.

In the upcoming months, | will

peek into the various ways | use
- Linuxin my job.

=

SJ Webb is a researcher coordinator.
When he is not working, he enjoys
time with his wife and kids. He
thanks Mike Ferarri for his
mentorship.
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Written by Ronnie Tucker

GUIDELINES

he single rule for an article is

that it must somehow be
linked to Ubuntu or one of the
many derivatives of Ubuntu

RULES

* There is no word limit for articles, please Follow these guidelines :

but be advised that long articles
may be split across several issues.

* For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7

 Write your article in whichever
software you choose, | would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

* In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

. document.

* Images should be JPG, no wider
. than 800 pixels, and use low
. compression.

(Kubuntu, Xubuntu, Lubuntu, etc). : * Do not use tables or any type of

. bold or italic formatting.

If you are writing a review,

When you are ready to submit

your article please email it to:
. articles@fullcirclemagazine.org

. TRANSLATIONS

If you would like to translate

. Full Circle into your native

- language please send an emailto
: ronnie@fullcirclemagazine.org and |
. we will either put you in touch with :
. an existing team, or give you :
- access to the raw text to translate
. from. With a completed PDF, you

- will be able to upload your file to

- the main Full Circle site.
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Write For Full Circle Magazine

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

title of the game

« who makes the game

e isit free, or a paid download?

» where to get it from (give download/homepage URL)
* is it Linux native, or did you use Wine?

 your marks out of five

« a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

» make and model of the hardware

» what category would you put this hardware into?

« any glitches that you may have had while using the hardware?
* easy to get the hardware working in Linux?

« did you have to use Windows drivers?

» marks out of five

» a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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LINUX'LAB

Written by Charles McColm

S everal months ago, | migrated
one of the software packages
we use at work to a new server.
Getting time to focus on
something as large as a server
migration is rare for me since |

usually have a bit less than 6 hours :

- all the necessary upgrades to get
. to version 4.1, then tackle backups. : _, 40
. As it turned out, we were regularly :

. backing up the database and

a week to look into anything new.
In this instance, | was familiar with
the software package, PCRT (PC

Repair Tracker), but the migration

was both a change in hardware and :
. installation didn’t go so smoothly

- on the new server.

updated software - what could
possibly go wrong?

Our original “Repair Tracker”
was running smoothly to this
point, but there were several
problems:

» We were using a fairly outdated

version of PCRT (v2.2 when 4.1 was
. issue with other software. The
. solution was to run an older
on wasn't in as secure a location as : version of PHP (we ended up with
. two versions of PHP installed with
. the older active). Lorna Jane

. Mitchell (author of PHP Web

. Services and PHP Master) also ran
. into this issue and documented

. which PPA she used to install both

- versions of PHP, | just reversed the

out).
* The “server” we were running it

most of our other servers.

* We weren't even sure we had
regular backups (we had a “dd”
backup that was old, so we could
restore the machine if we needed
to, but we wouldn’t have recent
data).

» We've started to virtualize more

servers and this was another
. physical machine that could break
. down.

The plan was to migrate the

software, but as hinted, the

The problem? Ubuntu 16.04

sysadmins had run into a similar

second last step:

; sudo add-apt-repository
: : ppa:ondrej/php

. existing database and v2.2 of PCRT © _ .~
to our newly spun virtual server, do :

: sudo

: sudo

: sudo

. answer, there were a number of

: . PHP 5.6 dependencies | also
. server. More accurately, the newer :

. version of PHP on Ubuntu server
. and PCRT 2.2 didn’t seem to jive
- well together. Luckily, one of our

. needed to install, but they all got
. sorted out by reading the error
- logs during the install of PCRT.

Upgrading and Downgrading Packages

https://lornajane.net/posts/ZO16/pE
. hp-7-0-and-5-6-on-ubuntu :

apt update

apt install php5.6
a2dismod php 7.0
a2enmod php5.6

service apache2 restart

virtualized PHP software packages,

- one of which was PCRT, the other

. Owncloud. Because it seemed the

- simplest route to get PCRT

. installed, we installed Ubuntu

. server 14.04. But that turned out

. to be a mistake because Owncloud
. wanted a later version of PHP (5.59
. was installed; it needed 5.6).

In this case, | employed the

same tactic, but ran a2dismod for

. version 5.59 and a2enmod for 5.6.

Of course this wasn’t the only

. Better planning might have

. foreseen this problem, but often
. time is precious and | end up

. having to figure out issues as we
. go. Two separate virtualized

. environments would have also

. solved this problem, and it's the

All of this could have been

- avoided if we just installed Ubuntu
. server 14.04 and used the version
. of PHP default with it, however

. one of our goals was to be as up-

. to-date as possible, and, when |

. took this approach on another

. development machine, it also

- didn't quite work out as expected.

On that development machine
we wanted to run a number of non-
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. direction we're headed, but it just

got me thinking that it's a bit of a

. pain having to maintain several
. versions of PHP to run the
. software we want to run.

Technologies like Docker

. suddenly seem more viable, even
- For a smaller organization.
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REVIEW

Written by Paul Romano

Etcher

E tcher is a cross-platform GUI
application to flash OS images
to SD cards & USB drives, safely :
and easily. The OS images can be in :
the format of .iso, .img or .zip files. :
It was originally released on 5 April :
2016, and on 12 May 2017 version :
1.0.0 was released.

* Microsoft Windows 7 and later
- (32-bit & 64-bit)
: »macOS 10.9 and later

! INSTALLATION

The downloads for Linux are

provided from the home page in a

: zip file of the Applmage package

From the web site: “Etcheris a
powerful OS image flasher, built
with web technologies to ensure
flashing an SDCard or USB drive is a
pleasant and safe experience. It
protects you from accidentally
writing to your hard-drives, ensures
every byte of data was written
correctly, and much more.”

More specifically... Etcheris
hard-drive friendly. It makes drive
selection obvious to avoid wiping
your entire hard-drive(s). After
flashing, it goes on to validate the
burnt image, so that there is no
more writing images on corrupted
cards and wondering why your
device isn't booting.

Supported Operating Systems
* Linux (32-bit & 64-bit) - most
distros

. Format. Applmages are self-

: contained runtimes that do not :
: require manual installation or root
. (but do require you to give them
: the necessary permissions to run

: as a program). They will run on

: pretty much every distro out there
: — just download, and double-click
© to run. (This paragraph originally

. from OMGUbuntu).

Alternatively, if you have a

Debian or Ubuntu based distro,
- you can install Etcher from the
command-line by:

Save the following as

/etc/apt/sources.list.d/etcher.list
(this is a one-line command):

: deb
: https://dl.bintray.com/resin-

io/debian stable etcher

Trust Bintray.com's GPG key

(also a one-line command):

; sudo apt-key adv —-keyserver
: hkp://pgp.mit.edu:80 —-recv-
: keys 379CE192D401AB61

Update and install:

; sudo apt—get update

; sudo apt—-get install etcher-
! electron

The etcher-electron package is

68.4 MB.

. UNINSTALL

; sudo apt—get remove etcher-
: electron

; sudo rm :
: /etc/apt/sources.list.d/etche :
i r.list :

g sudo apt—-get update

UsE

| have used Etcher to burn

images to only USB sticks. Until |
. get one, | will leave it to the :
: Raspberry Pi users out there to try :

it with SD cards. The numbers 1-7
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. below refer to the screenshots.

The interface is very easy to

© use:

In the top rjght-hand corner are

: two icons. The question mark takes
. you to the Help Page. The gear

: icon takes you to a simple Settings
. screen.

Seftings

: Back on the main screen, click

. on the left-most icon (a plus sign)
. and select the image (.iso, .img or
. .zip) that you wish to burn:
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Plug in your USB stick and it is
automatically recognised,

to be flashed.

ETCHER

After a few minutes the screen

will change to show that the flash
unmounted if necessary, and ready

is complete.

ETCHER

Click on the right-most icon to
start the actual flashing. The bar
changes to indicate progress.

ETCHER

burnt image is validated and again
progress is indicated.

& Flash Complatal

Thanks for using - SETCHER

made with ¥ by i resin.io

To CoOME

According to the Etcher

. website, future improvements will
g: include 50% faster burns, and

. simultaneous writing for multiple
: drives.

ETcHER CLI

Also released at the same time

When Flashing is completed, the : as version 1-0'9 was a com'mand-
. line tool that aims to provide all
. the benefits of the Etcher desktop

. application in a way that can be run:

from a terminal, or even used from

a script. However, you are warned
that the CLI version is currently

. experimental and to proceed with
© caution.

: CONCLUSION

| have been happy burning

images to USB sticks using the

. command-line. However, this is a

8 - multi-stage process. Firstly, many
. distros automatically mount USB

. sticks so you must find out what
- device the stick is identified as, and :
. then unmount it. Secondly, you

. must remember to prefix the dd

. command with sudo and then

. enter your password. This dd

: command has the potential for

. disaster. If you incorrectly identify
: your output device, you could

. easily destroy data on a hard-drive. :
. Thirdly, to verify the integrity of
. the files, you can:

. » Boot from the newly flashed :
- device and hope there is an option
© in the boot menu to check the files. :
: Or :
. »You have to mount the device,
. look for a file called MD5SUMS,
. SHA256SUM.txt or something :
- similar, and then decide what is the :
appropriate command to verify the :

integrity.
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In comparison, Etcher does all
of the above automatically and

: easily. | think Etcher is worth

: keeping an eye on, especially if it
© can reach its goals of faster burns
: and simultaneous writing for

: multiple drives. A persistent

© storage option would be nice as

- well.

. REFERENCES

' Home Page: etcher.io/

: GitHub: github.com/resin-io/etcher

Help Page: github.com/resin-
: io/etcher/blob/master/SUPPORT.m
i d

© Review:

www.omgubuntu.co.uk/2017/05/h

: ow-to-install-etcher-on-ubuntu
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S nappy allows you to install an
automatically and Fully
updated, properly stable

application on any distribution that
supports it. This currently includes :

Ubuntu, Fedora, Arch, Debian,
openSUSE and Gentoo. Snappy
applications can even be installed
from the graphical software
center, if the software center
supports it.

Why is installing an
automatically and Fully updated,
properly stable application on
Linux not currently possible? Well

this is a big problem on the current
. configuration tasks, which an

ordinary end-user should not have
- to do. Further, updates to

Linux desktop. There's an
apparently unresolvable dilemma
between having stable

applications and having up-to-date :
applications. This arises due to the :
- features of the desktop which

. should never be broken, not just
. applications. Antergos broke

: LightDM Ffor at least a few hours
. (possibly more if it was a while

nature of the Linux desktop's
shared dependency system. If you
have fully up-to-date
dependencies all the time—i.e., a
rolling-release distribution

model—you may find that you end
. and when the developers filed a

. blog post on it). If millions were
- using the Antergos operating

up breaking slightly older
applications that haven’t been
updated upstream to work with
the newer dependencies. This

MY OPINION

Written by Adam Eveleigh

© means that users are faced with
. significant bugs which they should
. never have had to deal with. It's
impossible to test properly for
these occasions because, in order
- to get the updates out as fast as

. possible, the testing period is very :

. short—which means less time to
- catch the bugs, and less time to
. make patches to fix them. You may
. think that this is possible, but :
: reality has shown that it is not. On
. pressing those who claim that

. distributions like Arch, Antergos

- and Manjaro are stable, you find

: that actually they have to do

various package management and

dependencies on these rolling
distributions can break key

between when the bug occurred

system, this would have resulted in

a great many unhappy users.

model. As for the release-based
distributions, they have the
. opposite problem. They may not

. so they get bugs that way. If you

. update the dependency, you risk

. introducing bugs into other

. programs that depend on the

. same dependency, and this is why
: PPAs on Ubuntu, for example, can
. be quite risky and why packages

. aren’t always kept completely up-
. to-date by default in the First

. place.

. to-date applications that work :
. without these dependency-related
. bugs? Well, you allow the

. developer to bundle the

. dependency versions that they

. expect! This means that an update
. to a dependency does not resultin :
. users being left with a broken

. application; the developer of the

dependencies and their

. application, ensuring that it still

So much for the rolling-release

be able to install a newer

. application because they rely on
. and expect a newer dependency

that isn’t yet in the distribution —

So how do we get properly up-

application can update the
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works correctly, in their own time.
: Snappy adopts this approach.

. There are still a few shared

. dependencies like libc, but much

. less than there were previously.

At this point, people complain

. about the file size. The file size

. does now increase because you

- have multiple copies of the same
. library used on the operating

. system. This is probably the only

. real disadvantage of snappy, but
. there are several reasons why this
. is not as big an issue as it seems.

. Firstly, with delta updates, once

. you have a snap installed, your

. computer downloads only a small
. amount of data to update the

. snap. Secondly, the file size of

. individual snaps can be cut down

by stripping out unneeded

. features of dependencies, like

. Peek has done with ffmpeg and

. imagemagick. Thirdly, there’s

. usually quite a lot of a hard drive

space on today'’s laptops and

desktops, so a big file size isn’t too
. much of anissue. Finally, thereis a
- precedent for this way of handling
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packages: Android, for example,
which has many duplicate Jar files,
and even macOS and Windows, to
a lesser extent.

There's another big advantage
of snappy that makes it worth

without a prompt, like in
ChromeQS, so there is less user
interaction and users can just get
on with using their operating
system. Could this mean that an
update breaks the app without the
user's permission? Perhaps, but
this is less likely because there’s
few shared dependencies and
updates can be rolled back if
necessary. Perhaps this seems
insecure? But the applications are

your whole system (they can if
they need to - if they use classic
confinement, but these snaps are

the snappy store), so this is not
really a problem. Indeed, the
confinement of snaps is itself
another reason why snappy is
great. They're confined Android-
style, they have access to only
certain parts of the system, not
the entire Filesystem like with
Linux applications packaged
traditionally. Programs that really
need to access the filesystem, like

code editors, can do so, this is
called Classic confinement, but the

: vast majority of snappy
. applications are confined properly. :
; : you can check out the snapcraft
. documentation, and you canask
. questions to the friendly snapcraft :
: community on the Forums, Rocket
: Chat, and Stack Overflow.

Snappy would make regular

. application updates on desktop
using: background updates happen :
- and will continue to result in a
. better end-user desktop :
. experience as development on the :
. format continues. But snappy is

. also excellent for developers

- writing desktop Linux applications.
. They need to write only one

- declarative snapcraft.yaml file to

. build a snap of their application,
- and only a couple of commands (or :
. even a couple of clicks) to get it :
. published on the snappy store and :
confined, they don't have access to :
- install which has snappy installed - :
. with no packager middleman.
. Despite the possibility of having no
manually reviewed before entering : :
. programmers like myself can get
. involved by helping upstream

- developers out by creating

. snapcraft.yaml files for them to

- adopt. Just go to the snapcraft

. (the name of the tool which makes :
: snaps) tutorial, complete it (20 :
. mins), then go and complete more :
. snapcraft tutorials if you wish (like :
* for Python, and websites), finda

Linux very easy for the end user,

thus published on every Linux

packager middleman, non-

program that hasn’t been snapped

yet, and snap it, then forward the
working snapcraft.yaml to the

. developer to use themselves. If

you face problems along the way,

This is our opportunity to solve

. an old problem with the Linux

. desktop and drastically improve
. the usability of that desktop for
- ordinary computer users. Let's

. grasp that opportunity.

Full circle magazine #122 @ 39

n contents



Sy

SHouLD LINUX DROP 32-BIT
- Lubuntu, Puppy, Android, and so

. forth, to continue providing both
. 32-bit and 64-bit.

SUPPORT?

don't think that it is a matter of
"should" or "shouldn't", but
rather of what is helpful.

For modern distributions
designed for modern machines,
e.g. Ubuntu, Mint, Kubuntu,
Fedora, Red Hat, and so forth —

point where supporting 32-bit
machines makes no sense. What
32-bit machine has the RAM and
CPU to support them?

However, there are still many,
many older devices in use
throughout the world, and I'll bet
that in poorer areas, replacing
them is not the cheap option that

society. Think about what is
probably the most popular Linux

old 32-bit smartphones will

next five or six years!

bit support. It would be welcome

LETTERS

for certain distros, such as

| realise that this is more work

. for the people who create these
. products, so naturally we cannot
. insist that they do so. However, |
. hope that they will manage to have :
. the resources to continue to

‘ . support both 32-bit and 64-bit, at
even Xubuntu — it has come to the ' least for the next (say) five years —
. until the relevant hardware :
. becomes so cheap relative to

. today that replacing old devices

. becomes viable for the poor.

Paddy Landau

it would be for those living in a rich PYTHON 2.x TO 3.x?

I 'm beginning to learn
distribution on Earth: Android. The : :
. about Python. Recently | found Full :
probably be around for at least the : Circle, but I had some issues why
. try to apply, and when | asked |
. found out that the code in the

For their sakes, we still need 32- : magazine is for an older version, so

programming and | thought

| thought that if | asked you to

If you would like to submit a letter For publication, compliment

or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

make a new update for the 3.6 :
. version, | may be lucky and have an :
. answer. I'll be grateful. :

Ahmed EB-BANA

Greg replies: All the code from

the early versions was produced for

Python 2.x. After a while, | tried to

. stick to code that would support
. versions 3.x as well as 2.x.

Not all code, however can easily

support both major versions of
. Python. This is the reason for so :
- many libraries not being available in :
© 3

The usual culprits are the print

statements since Python 3
. REQUIRES the statement to use
. parens. Try converting:

; print x

to

; print (x)

(in other words, try to enclose
the statements following the word
"print" in parens.)
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Join us on: *

w goo.gl/FRTML
-

@3 facebook.com/fullcircle
magazine

E twitter.com/#!/fullcirclemag

in

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

FuLL CircLE NEEDS You!
A Without reader input

- Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small

things like letters and desktop
screens help fill the magazine.

See the article Writing For Full
Circle in this issue to read our
basic guidelines.

Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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LETTERS

There is one other thing you can
try, There is a conversion utility that
is included with Python 3.x which is
called 2to3. | briefly touched on this
in part 16 of the series which was in
FCM#42.

UPDATING THE KERNEL

yoga 300. It is a nice laptop
which lacks some power, but

well for general stuff and image
editing which is my thing. I like to
use LTS versions of Ubuntu.
Xubuntu 16.04 uses kernel 4.8
which lacks some drivers for this
machine, the main one being for

power and battery information and :

management. | read that it is easy
to change kernels but, not having
done that before, researched it a
bit carefully. | tried the app for
kernel management which some
recommend as the easy way to do
it but that failed. So | downloaded
kernel 4.10.11 from
http://kernel.ubuntu.com,
following the instruction to
download the header files and the
kernel.deb files. Then a sudo dpkg
-i *.deb did the magic.

After a reboot the battery tools

. were working in the XFCE taskbar. | .
. have done some extensive testing,
- and, so far, everything seems to '
. work very well on this hardware.
: Yet another win for Linux | say.

| know that 17.04 has the 4.10

. kernel but | did not want to

- reinstall unless I had to,and now | :
- should be able to run 16.04 on this :
have recently acquired a Lenovo hardware through to the next LTS. :
. These are the great things about

- Linux, and the community who
Xubuntu runs well on it and it does : Share information out so that
. people like me can benefit. So :
. thanks for all the work you do, it is :
. appreciated. Full Circle is a great
. magazine which | look forward to

© receiving.

lain Mckeand
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Q&A
©

Q How can | change where

Cheese saves the pictures it
takes?

You might need to install
dconf-editor.

When | run dconf-editor, | can
go to org/gnome/cheese/photo-
path. I toggle "Use default value"

and enter "Pictures” as the Custom

value.

Sure enough, Cheese saves
images in my Pictures folder.

Q I'm having trouble running
scangearmp on Linux Mint
18.1.1'm using a Canon mg6320
and would like to get the scanner

going.

(Thanks to pdcin the Ubuntu
Forums) For quite a few years

3 formats for Linux users: rpm
packages, debian packages, and
source code. Mint uses Ubuntu;
Ubuntu uses Debian, so debian
packages are used; so just use a

Compiled by Gord Campbell

debian package from Canon.

For the MG6300 series drivers, | :
: would start at the Canon Asia
© website http://support-asia.canon- :
© asia.com/?personal and that takes
: me to http://support-asia.canon-

: asia.com/contents/ASIA/EN/01004 :
© 70702.htm! and you get

: scangearmp-mg6300series-2.00-1-

deb.tar.gz

So that is a debian package,

. compressed into a tar.gz format. It
© isa 5yrolddriver;if you wereto
© click to download and select SAVE, : I'm doing a
- it should end up in your Downloads :

. folder. Commands to install; one

: line at a time, and hit ENTER after

. each paste, would be:

; cd Downloads

tar -zxvf scangearmp-
: mg6300series—-2.00-1-
: deb.tar.gz

i ed scangearmp-mg6300series—

now, Canon has supplied driversin : 2-00-1-deb

; ./install.sh

and then to run it the command
* would be:

If you have a Linux question, email it to: misc@fullcirclemagazine.org, and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

! scangearmp

My primary drive has started

: UEFI boot sector, and three

: operating systems on it, I'd like to
. clone the device to a new disk. Can
: | just do this with dd?

A (Thanks to TheFuin the

Ubuntu Forums) Same here.

! sudo ddrescue —--force
: /dev/sdb /dev/sda
i /tmp/log.file

Where sdb is the source, and

sda is the target.

This is backwards from what

. most people would see. | swapped
: the ports on purpose and powered :
. down/removed all other storage
: (about 20TB) to prevent issues.

Using ddrescue is important

* since it will continue AFTER errors

are seen.
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When all done, I'll restore the

backup from 3 days ago to fix any
. failed sectors from the original.

: _ =0 Last time I looked, about 90MB of
to fFail SMART testing, running :

: afoul of the "reallocated sectors”
: problem. Since this device has the

. errors were shown in the ddrescue
: output.

That single command will

© create all the formatting,

¢ partitions, LVM stuff, everything.
At first reboot, | expect to have to
: change the UUIDs for the
partitions. But since I'm still trying
. torecover the last possible bits, |

© cannot say for certain that my plan
- will work.

ddrescue completed. Lots of

: bad sectors, a few important, but

: the system booted. boot, lvm,

© partitions, and most data were all

: handled as expected. The 2nd GPT
: record was corrupted. Easily fixed.
: Replicated the data from the

: backup disk back over. Life is good.

Had a corrupt DB (it was a

media center), restore fixed that.

If the clone hadn't worked, |

would have followed my normal

restore processes for that
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Q&A

machine.

(From the Original Poster)
Happy to report that ddrescue did
the trick, although the drive did
not display any errors. | guess the
SMART warning was early enough
that the problematic sectors had
yet to be used. Plugged in the
replacement drive, ran

sudo ddrescue -f /dev/sda
/dev/sdb /tmp/mapfile

and waited for it to complete.
Swapped the cables and booted
successfully off the replica.

Q I'm unable to mount the Win
10 disks in my PC when in
Ubuntu. | get an error message
about an "unclean file system."

(Thanks to kagashein the

Ubuntu Forums) Shutdown
Windows using the following
command:

Shutdown /s /t O

Q During startup, three error
messages flash by too quickly

. for me to write them down. How
: can | getrid of them?

A Use your phone to take a :
: video of the startup sequence. :
. Plug the exact text of a message  : https://g00.9l/5YgfpU
. into Google, and you will probably

. find your answer.

. TOP QUESTIONS AT
. ASKUBUNTU

* Making a PDF document
. https://q00.gl/aLO4AG

. * What is the "wanna Cry"

: ransomware's possible impact on
© Linux users?

: https://q00.9l/GNHPgc

* How can | know from which
. partition | had booted?
. https://goo.ql/XCOATG

. * Does someone other than
: Canonical provide paid support for :
. Ubuntu? :
. https://go0.gl/iTm9ct

| * Write the dynamic output of

terminal into a text File

https://goo.gl/CFXKpw

. * Where do files rsynced to a host
- go?
https://go0.gl/2P5bkt

* How to open two different files

using the vi editor?

: * Purging a software package,
. reinstalling it, it remembers

. settings

: https://go0.9l/4cZyTy

. * What would cause aninstalled
. application to not be recognized as :
. such?

: https://q00.9l/pYHE8Z

. TiPs AND TECHNIQUES

What the big boys want

W e all like a distro which
installs smoothly and

: quickly, but for some peopleiit's
. essential.

; Many large web sites run on on- :
. demand servers, where they pay
. based on the resources they use. A
~ large site might have hundreds, :
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thousands, even hundreds of
thousands of virtual machines

running. Then demand goes up a
. little, and they need several
- hundred more VMs -- right now.

How quickly can the additional

VMs start serving clients? That is a
. major competitive measurement.

It's a different world from what

: "we" experience - you know,

. people running a desktop or laptop
: computer with Linux as the

. operating system.

This is where we get into a lot

. of foreign terminology, such as

. Openstack, Docker, Vagrant,

: MAAS, LXD, containers, and system
. images.

| haven't seen any benchmark

results, but speed of deployment
. must be one of the factors helping
Ubuntu succeed in the cloud.

=

Gord had a long career in the
computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy'
at a 15-person accounting firm in
downtown Toronto.
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Written by Oscar Rivera

UBUNTU GAMES Siltbreaker Ack 1

alve has just released : Battle Pass is very similar to last In typical Valve fashion, the in early June. After | got a Battle

Siltbreaker Act 1 which is a . year's, with a few changes, the . original release was delayed. The  : Pass, | was disappointed that |
new, story-driven, campaign-style, : main change being the addition of game was scheduled to be . wouldn't be able to review the
action-adventure, co-op game. The : the Siltbreaker campaign game released sometime during May : game in time for this month’s
game was released on June 8, 2017 : : 2017 but ended up being released : magazine but, just in the nick of

and, although it was one week late, :
it's a welcome addition to my video :
game library. It's a tough game to
play, but in the couple of days I've
played it, it's been a very :
rewarding experience. The game is :
actually more of a game withina
game as it is available for owners

of 2017 Dota 2 The International
Battle Pass for the low price of
$9.99 which can be bought either
within Dota 2 or else separately
through Steam'’s Battle Pass page

at :
http://www.dota2.com/internation :
al/battlepass. Siltbreaker, like Dota :
2 is developed and released by :
Valve, the company behind the
Steam game engine. Battle Pass
owners get a bunch of other items
besides Siltbreaker, and proceeds
from the sales of the Battle Pass

go toward the prize pool for this
year's The International 2017 event : |
which will be held in Seattle, :
Washington from August 7th
through the 12th, 2017. This year's
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time, Siltbreaker was released.

My expectations were high and
the excitement was almost at

was released. It was a most
definite welcome sign when |
started Dota 2 on June 8 and
immediately there was a banner
informing me of Siltbreaker now
being available.

Upon starting Siltbreaker, a
digital comic book appears which
slowly tells of the tale behind
Siltbreaker concerning the

mouse-click is required to cycle
is pretty interesting and can be

read while you wait for the
network to match you up with a

team. Once your match begins, the

first thing you must do is select a
hero with which to play the game.
The game is limited to only 14

heroes out of the 110+ available in

a regular game of Dota 2. The 14
available heroes play very much
like they play in a regular game of

Dota 2. The items you build are the
same for the most part, except for

new items that are available only
in Siltbreaker. Leveling up your
hero is also similar to Dota 2... but
this is where the similarities end

and the differences begin. From
here on, Siltbreaker sits on a class

- all of its own and feels & plays very
. different from Dota 2.
boiling point by the time the game :

before being able to reach and

You have to progress through

PLAY SILTBREAKER: ACT |

different zones to beat the game.
The first couple of zones are not

too hard, but they introduce the

. concept of the game and give you
. an idea of what to expect. Unlike
: For starters, you are teamed up
. with three other players which

' makes you belong to a team of

. four instead of the standard 5v5 in
. Dota 2; not to mention the fact

. that you're not playing against

. other players but rather you're

. playing against the computer Al.

. The campaign is rather hard to

. beat, and will definitely require

. you to run through it a few times
happenings in the Dark Reef. A left
. defeat the final boss Rhyzik.
through the comic book. The story

Dota 2, the camera is not

controlled 100% by the player but
. rather it moves with you as you

. make your way through each zone.
. As you explore each zone, you

. encounter lots (and | do mean lots)
. of foes along the way. In addition

. to these enemies, some of the

. zones have a mean, scary boss that :
. needs to be beat. Unfortunately
. there are few guides available as
. of now - because the game is so
. new — but, by the time you read

. this, I'm sure there will be more

. than a handful of guides to help

you along your way.

Some of the levels (or zones)

- will have other obstacles besides

- enemies — kind of like puzzles that
- need to be timed properly to get

. through. One of the unique

. aspects of this game is that it

. doesn’t allow you to save your

. progress —which means it has to

. be beat in one sitting or not at all.

. So, for older gamers like me, this is
. reminiscent of the old arcade

games when you put in a quarter

- and played on that arcade machine
. until your character died. In fact,

. this almost reminds me of the

. classic The Gauntlet video game.

. Even if you don’t beat the game,

. there is still benefit to be gained

. from playing it as each zone will

. award you anywhere from one to

. three stars, depending on different
. factors, as long as you perform

- well. One star will give you 200

. points toward your Battle Pass,

: two stars will give you 400 points

. toward the Battle Pass, and three

- stars will give you a treasure which
- will contain rare and hard-to-find

: items that are available only

. through this game.

The game is played with a

' mouse & keyboard, and, depending

on which hero you select, the
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actions for your key bindings will
differ. The graphics are
phenomenal but, at times, it

action on the screen and it may
even feel a bit too clustered. The
surround sound is superb, and the
accompanying soundtrack is
deserving of an award. | have not
encountered any problems yet
with the game in the few days I've
been playing it except for Internet
lag from other players — which
once forced my team to pause a
couple of times to allow for the

connect. But | suppose that's

. may be sometime in September

: 2017. Then again, if Valve has

. enough positive feedback from

: gamers, there is a small chance

. that this game might live to see

- another day beyond its expiration
. date. Not having released any new :
: content in quite a while (fans are

. still waiting for Half-Life 3), it :
. wouldn't be a bad idea for Valve to :
. give Siltbreaker the chance to stick :
player who had disconnected to re- : ;

seems like Siltbreaker will be a
limited edition game that will

- vanish shortly after the completion :
almost seems like there’s too much :

of The International 2017, which

something to be expected from co- L

op multi-player online games
anyway.

| enjoyed playing Siltbreaker
very much. Perhaps my only
complaint about it is that there is
no tutorial at all. The only way to
learn how to play this game is to
just jump right in and start playing
it, which can be intimidating —
especially if you take into account
that other players with whom you

might be paired up are likely to get
annoyed with your mistakes due to :

your lack of experience.
Siltbreaker Act 2: A Vault in the
Deep is due to be released in July
of this year. Unfortunately, it

around for a while. Although I've
really enjoyed playing Siltbreaker,
the fact that it will most likely go

: away in a few months and the lack
. of any sort of tutorial makes me

. deduct a whole star from my

: rating.

L, |
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. Minimum Requirements

. Operating System: Ubuntu 12.04 or
. newer

. CPU: Dual core from Intel or AMD

- at 2.8 GHz

- RAM: 4 GB

- GPU: Nvidia GeForce 8600/9600GT

- (Driver version 331 or newer), AMD
. HD 2xxx-4xxx (Driver mesa 10.5.9),

~ Intel HD 3000 (Driver mesa 10.6)

- Hard Drive: 16 GB available space

- Additional Notes: Broadband

- Internet connection

=

Oscar graduated with a music degree
from CSUN, is a Music
Director/Teacher, software/hardware
beta tester, Wikipedia editor, and
active member of the Ubuntu
community. You can email him at:
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MY DESKTOP MY DESKTOP

Written by The_LinuxGK Written by David

- ! § B Eies) 4e 3237 E

'm using Ubuntu (16.04) but with
a pretty standard desktop. :

: Below you'll find Docky and | have

- hidden the Unity bar. | like this :

© background pic that | found on the

internet, so took that one. :

buntu Mate 16.10 Ambiant  ©  Haye a nice day!
Mate / Humanity Icon Set (in

Greek language), with

transparency on the bars

Wallpaper: :
http://www.wallpapermania.eu/wa :
llpaper/funny-little-squirrel-with-
almonds-hd-animal-wallpaper

Full circle magazine #122 @ 47 & contents »


http://www.wallpapermania.eu/wallpaper/funny-little-squirrel-with-almonds-hd-animal-wallpaper

MY DESKTOP

Written by Vince

am currently using Elementary
0OS 0.4 Loki (64 bit). 1 am a big

some time ago | discovered
elementary OS. Its simplicity and
nice look and feel made me give it
atry.

As you can see, | like a look and
feel very clean and relaxed with
just a Few indicators — (My-
Weather-Indicator and System-
Monitor-Indicator) and the Insync
application for Google drive

L
A
i
S

i
|
|I|

. (https://www.insynchg.com) at the :
. top of the screen. :
enthusiast of Linux and | have been :
using Ubuntu for several years, but :
. and it is improved by a very :
- beautiful set of icons called "Sardi" :
. (https://qithub.com/erikdubois/Sar :
: di)

MY DESKTOP

Written by Siddharth Sundaresan

have a HP 630, which originally
came with Windows 7, an

introduction to any form of Linux.
Since then, | have experimented

- with many distributions and have a : 14.04, with Unity, GNOME (with

folder containing ~120 gigs of ISOs :
. for live booting....

: Display: 1366 * 768 HD

: Processor: Intel Core i3 @ 2.40 GHz * 4
: RAM: 4GB

: HDD: 320 GB Internal Hard Drive + 1 TB
: Sandisk External HDD

Graphics: Intel IronLake mobile
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All my drivers, including

: wireless, processor and
. operating system | had used for 2.5 :

My theme is basic "Elementary” : years. | switched to Ubuntu 14.04

: Unity in "15, which was my first

. multimedia keys are supported
. perfectly in all the distributions
: I've tested so far.

Operating System: Ubuntu

: PixelSaver extension, as seenin

: the screenshots), XFCE and KDE4
: on the Internal Hard disk.

: OpenSUSE GNOME Next on

: External HDD. Fedora 26 Alpha on
: aflash drive. feren OS for testing,
. and possibly reviewing...

n contents


https://www.insynchq.com
https://github.com/erikdubois/Sardi

MONTHLY PATRONS

2016:

Bill Berninghausen
Jack McMahon
Linda P

Remke Schuurmans
Norman Phillips
Tom Rausner
Charles Battersby
Tom Bell

Oscar Rivera

Alex Crabtree

Ray Spain

Richard Underwood
Charles Anderson
Ricardo Coalla
Chris Giltnane
William von Hagen
Mark Shuttleworth
Juan Ortiz

Joe Gulizia

Kevin Raulins
Doug Bruce

Pekka Niemi

Rob Fitzgerald
Brian M Murray
Roy Milner

Brian Bogdan
Scott Mack

Dennis Mack

John Helmers

JT

Elizabeth K. Joseph
Vincent Jobard

Chris Giltnane

Joao Cantinho Lopes
John Andrews

2017:

. SINGLE DONATIONS

2016:

John Niendorf
Daniel Witzel
Douglas Brown
Donald Altman
Patrick Scango
Tony Wood

Paul Miller

Colin McCubbin
Randy Brinson
John Fromm
Graham Driver
Chris Burmajster
Steven McKee
Manuel Rey Garcia

Alejandro Carmona Ligeon

sinisa vidovi¢
Glenn Heaton
Louis W Adams Jr
Raul Thomas
Pascal Lemaitre

PONG Wai Hing
Denis Millar
Elio Crivello
Rene Hogan
Kevin Potter

Marcos Alvarez Costales

Raymond Mccarthy
Max Catterwell
Frank Dinger

Paul Weed

Jaideep Tibrewala
Patrick Martindale
Antonino Ruggiero
Andrew Taylor

2017:

Linda Prinsen
Shashank Sharma
Glenn Heaton
Frank Dinger
Randy E. Brinson
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The current site was created thanks to
Lucas Westermann (Mr. Command &
Conquer) who took on the task of
completely rebuilding the site, and
scripts, from scratch, in his own time.

The Patreon page is to help pay the
domain and hosting fees. The yearly
target was quickly reached thanks to
those listed on this page. The money
also helps with the new mailing list that
| set up.

Several people have asked for a PayPal
(single donation) option, so I've added a
button to the right side of the website

A big thank you to all those who've
used Patreon and the PayPal button.
It's a HUGE help.

https://www.patreon.com/
Fullcirclemagazine

DONELE
LAY r

https://paypal.me/ronnietucker
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Full Circle Team

Editor - Ronnie Tucker

") HOW!/TO CONTRIBUTE
@

ronnie@°fullcirclemagazine.org
- FCM#123
FULL CIRCLE NEEDS YOU! Deadline: Web.master-. Lucas Wes.termann
A magazine isn't a magazine without articles and Full Circle is no Sunday 09th July 2017. admin@fullcirclemagazine.orq
exception. We need your opinions, desktops, stories, how-to's, Release:
reviews, and anything else you want to tell your fellow *buntu users. Friday 28th July 2017. . .
Send your articles to: articles@fullcirclemagazine.org E‘?'t'“g & Proofreading
Mike Kennedy, Gord Campbell, Robert
We are always looking for new articles to include in Full Circle. For help and advice Orsino, Josh Hertel, Bert Jerred, Jim
please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471 Dyer and Emily Gonyer
Send your comments or Linux experiences to: letters@fullcirclemagazine.org Our thaf‘ks go to Canonical, the many
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org translation team.s around the world
Questions for Q&A should go to: questions@fullcirclemagazine.org g and Thorsten Wilms for the FCM logo. )

Desktop screens should be emailed to: misc@fullcirclemagazine.org
... Or you can visit our site via: fullcirclemagazine.org

Getting Full Circle Magazine:

For the Full Circle Weekly News: L.J EPUB Format - Most editions have a link to the epub file
. . on that issues download page. If you have any problems
: You can keep up to date with the Weekly News using the RSS . . o . . .

s“ Feed: http://Fullcirclemagazine.ora/feed/podcast with the epub Ffile, email: mobile@Ffullcirclemagazine.org
Or, if your out and about, you can get the Weekly News via @ Issuu - You can read Full Circle online via Issuu:
Stitcher Radio (Android/iOS/web): http://issuu.com/fullcirclemagazine. Please share and rate
http://www.stitcher.com/s?fid=85347&refid=stpr FCM as it helps to spread the word about FCM and Ubuntu.

=g ' and via Tuneln at: http://tunein.com/radio/Full-Circle-Weekly- m Magzster - You can also read Full Circle online via

> News-p855064/ Magzster: http://www.magzter.com/publishers/Full-Circle.
Please share and rate FCM as it helps to spread the word
about FCM and Ubuntu Linux.
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